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Overview

This guide provides information for installing the HP Codar application. Successful implementation of
the application requires knowledge of the integrated products, as well as the HP Codar solution.
Information in this guide augments information provided in the integrated products documentation but is
not intended to replace that documentation. Primary product documentation contains the most up-to-
date information. Cross-references are provided to those documents where appropriate.

System requirements

You should review the HP Codar System and Software Support Matrix for version requirements.

You can get this document from the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. You must sign in or register for an HP Passport.

Installation steps

The main installation steps depend on whether you are installing the embedded or external HP
Operations Orchestration to integrate with HP Codar. If you choose to integrate HP Codar with
embedded HP Operations Orchestration, embedded HP Operations Orchestration is installed
automatically with HP Codar.

Following are the main installation steps:
1. "Install and initially configure database" on page 10: Oracle, Microsoft SQL, or PostgreSQL.

2. "Install external HP Operations Orchestration” on page 25 (only if you chose to integrate with
external HP Operations Orchestration).

3. "Install HP Codar" on page 27.
a. "Install HP Codar on Windows" on page 27 or "Install HP Codar on Linux" on page 36
b. "Post-installation database configuration" on page 45

4. "Configure HP Operations Orchestration" on page 47.

5. "Post-installation" on page 62
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Install and initially configure database

You can install and configure one of the following databases:
« Oracle JRE, see "Oracle Database" below
« Microsoft SQL server, see "Microsoft SQL server" on page 16

« PostgreSQL, see "PostgreSQL" on page 20

Oracle Database

You must complete the following installation and configuration steps if you wish to use the Oracle
Database with HP Codar.

o "Install Oracle Database" below
o "Download Oracle JDBC drivers" below

« "Configure Oracle Database" below

Install Oracle Database
See the HP Codar System and Software Support Matrix, for a list of supported database versions.

Install the database according to the manufacturer's documentation. Database installation is typically
done in partnership with a database administrator.

Download Oracle JDBC drivers

For a list of supported JDBC driver versions, see the HP Codar System and Software Support Matrix.

Download a supported version of the JDBC . jar file(s) and save them on the system on which
HP Codar will be installed. Record the location where you save the files, because this information must
be provided when you install HP Codar.

Configure Oracle Database

These tasks must be completed before HP Codar is installed.

Note: These tasks are used with both embedded and external HP Operations Orchestration,
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except where indicated.

o "Create Oracle database instances for HP Codar" below

«» "Configure Oracle database user and schema for embedded HP Operations Orchestration" on the
next page

« "Configure Oracle database user and role for Identity Management component" on the next page
« "Configure Oracle database user and role for HP Codar" on page 13

« "Configure Oracle reporting database role and read-only user for HP Codar (required for reporting)"
on page 14

« "Configure Oracle for localization (required for localization)" on page 15

« "Create Oracle tablespace for HP Codar (recommended)" on page 15

Create Oracle database instances for HP Codar

Separate database instances are required for HP Codar and the components it uses. You must create a
separate database instance for:

« Embedded HP Operations Orchestration - only if you use embedded HP Operations Orchestration

« Identity Management component - if you use either embedded or external HP Operations
Orchestration

« HP Codar - if you use either embedded or external HP Operations Orchestration

Work with the database administrator to create a database that is used by the embedded HP
Operations Orchestration, HP Codar (if it has not already been created), and the Identity Management
component. See the HP Operations Orchestration Database Guide for more information about
database requirements for HP Operations Orchestration.

You must provide the System ID (SID) of these databases when prompted for the database information
during the installation of HP Codar. For example, when prompted for the HP Codar database
information, provide the SID of the HP Codar database. When prompted for the Identity Management
component database information, provide the SID of the Identity Management component database.
When prompted for the embedded HP Operations Orchestration database information, provide the SID
of the embedded HP Operations Orchestration database.

Note: For an Oracle database, SID is no longer used for the database connectivity. Instead of
SID, it should be SERVICE_NAME. You can run the following query to find the SERVICE_NAME on the
Oracle 12c/11g systems:

select global name from global name;
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Configure Oracle database user and schema for embedded HP
Operations Orchestration

A database user for embedded HP Operations Orchestration is required when installing HP Codar.
Work with the database administrator to do the following (or see the manufacturer's documentation for
more information):

Caution: On Windows, the database name and user name cannot contain more than one dollar
sign symbol ($). For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

1. Create a schema for the embedded HP Operations Orchestration by creating a database user (for
example, codaroodbuser).

2. Grant the following privileges to the user:
m CONNECT
m CREATE VIEW
m CREATE SEQUENCE
m CREATE TABLE
m CREATE PROCEDURE

For example, run the following commands to create the codaroodbuser user:

Create user codaroodbuser identified by codaroodbuser default tablespace system
temporary tablespace temp quota unlimited on system account unlock;

Grant CONNECT to codaroodbuser;

Grant CREATE VIEW, CREATE SEQUENCE, CREATE TABLE, CREATE PROCEDURE to
codaroodbuser;

Commit;

You must provide this database user name and password when prompted for the HP Operations
Orchestration database information during the installation of HP Codar.

Configure Oracle database user and role for I[dentity Management
component

A database user is needed when installing Identity Management component for HP Codar. Work with
the database administrator to do the following (or see the manufacturer's documentation for more
information).

Caution: On Windows, the database name and user name cannot contain more than one dollar
sign symbol ($). For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.
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To configure an Oracle database role and user for I[dentity Management component, complete the
following steps:

1. Create a schema for the Identity Management component by creating a database user (for
example, codaridmdbuser).

2. Create arole for this HP Codar database user (for example, codaridmdbrole) and grant the
following privileges to the role:

m CREATE SESSION
m CREATE TABLE
m CREATE VIEW
m CREATE SEQUENCE
m CREATE ANY SYNONYM
3. Grant the role to the HP Codar database user.
4. Alterthe HP Codar database user by setting this role as the user's default role.

For example, run the following commands to create codaridmdbrole and codaridmdbuser:

Create user codaridmdbuser identified by codaridmdbuser;

Create role codaridmdbrole;

Grant CREATE SESSION, CREATE TABLE, CREATE VIEW, CREATE SEQUENCE, CREATE ANY
SYNONYM to codaridmdbuser;

Grant codaridmdbrole to codaridmdbuser;

Alter user codaridmdbuser default role codaridmdbrole;

You must provide this user's user name and password when prompted for the Identity Management
component database information during the installation of HP Codar.

Configure Oracle database user and role for HP Codar

A database user is needed when installing HP Codar. Work with the database administrator to
configure the database role and user (or see the manufacturer’'s documentation for more information).

Caution: On Windows, the database name and user name cannot contain more than one dollar
sign symbol ($). For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

To configure an Oracle database user and role for HP Codar, complete the following steps:
1. Create a schema for HP Codar by creating a database user (for example, codardbuser).

2. Create arole for this HP Codar database user (for example, codardbrole) and grant the following
privileges to the role:
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m CREATE SESSION
m CREATE TABLE
m CREATE VIEW
m CREATE SEQUENCE
m CREATE ANY SYNONYM
3. Grant the role to the HP Codar database user.
4. Alterthe HP Codar database user by setting this role as the user's default role.

For example, run the following commands to create codardbrole and codardbuser:

Create user codardbuser identified by codardbuser;

Create role codardbrole;

Grant CREATE SESSION, CREATE TABLE, CREATE VIEW, CREATE SEQUENCE, CREATE ANY
SYNONYM to codardbuser;

Grant codardbrole to codardbuser;

Alter user codardbuser default role codardbrole;

You must provide this user name and password when prompted for the HP Codar database user during
the installation of HP Codar.

Configure Oracle reporting database role and read-only user for
HP Codar (required for reporting)

If you are using both the HP Cloud Service Automation and HP Codar licenses, you can use the HP
Cloud Service Automation reporting capabilities. If you want to use the reporting capabilities, you must
add an Oracle reporting database role and read-only user when installing HP Codar. For details about
the HP Cloud Service Automation reporting capabilities, see the HP Cloud Service Automation
Reporting and Auditing Whitepaper.

Note: You must be using both the HP Cloud Service Automation and HP Codar licenses to use
the reporting capabilities.

Work with the database administrator to create a role and read-only user to do the following (or see the
manufacturer's documentation for more information).

Caution: On Windows, the user name cannot contain more than one dollar sign symbol ($). For
example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

To create and configure a reporting database role and read-only user for HP Codar and HP Cloud
Service Automation, complete the following steps:
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1. Create a database user (for example, CODARReportingDBUser).

2. Create arole for this HP Codar database user (for example, CODARReportingDBRole) and grant
the CREATE SESSION privilege to the role.

3. Grant the role to the HP Codar database user.
4. Alterthe HP Codar database user by setting this role as the user's default role.

For example, run the following commands to create the CODARReportingDBRole role and
CODARReportingDBUser read-only user:

Create user CODARReportingDBUser identified by CODARReportingDBUser;
Create role CODARReportingDBRole;

Grant CREATE SESSION to CODARReportingDBUser;

Grant CODARReportingDBRole to CODARReportingDBUser;

Alter user CODARReportingDBUser default role CODARReportingDBRole;

If you configure this user, you must provide this user's user name and password when prompted for the
HP Codar reporting database user during the installation of HP Codar.

Configure Oracle for localization (required for localization)

If you need to support localization, the Oracle database instance must support UTF-8 character
encoding and multi-byte characters. Work with the database administrator to set the following
parameters to the specified values (or see the manufacturer's documentation for more information):

e NLS_CHARACTERSET = AL32UTF8

e NLS_LENGTH_SEMANTICS = CHAR

Create Oracle tablespace for HP Codar (recommended)

If you chose to install embedded HP Operations Orchestration, for performance reasons, HP
recommends that you create a new tablespace which stores LOBs forthe CODAR_DOCUMENT
table. Work with the database administrator to create a tablespace to be used by HP Codar (or see the
manufacturer's documentation for more information). HP recommends that the initial tablespace size
should be at least 3 GB.

Note: The tablespace must be created before installing HP Codar and then must be configured
immediately after HP Codar is installed.
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Microsoft SQL server

You must complete the following installation and configuration steps if you wish to use MS-SQL with
HP Codar.

"Install Microsoft SQL Server" below

"Configure Microsoft SQL Server" below

Install Microsoft SQL Server

Database installation is typically done in partnership with a database administrator. The Microsoft SQL
Server must be installed with mixed mode authentication. During the installation of the Microsoft SQL
Server, select Mixed Mode (SQL Server authentication and Windows authentication) from the
Database Engine Configuration dialog for the authentication mode.

See the HP Codar System and Software Support Matrix for a list of supported database versions.

Configure Microsoft SQL Server

The following tasks must be completed before HP Codar is installed. Work with the database
administrator to complete these tasks, or see the manufacturer's documentation for more information.

Note: These tasks are used with both embedded and external HP Operations Orchestration,
except where indicated.

« "Enable TCP/IP on Microsoft SQL server " below
« "Configure Microsoft SQL server database user for HP Codar" on the next page

« "Configure Microsoft SQL reporting database role and read-only user for HP Codar (required for
reporting)" on the next page

« "Configure Microsoft SQL server database user for embedded HP Operations Orchestration " on
page 18

« "Configure Microsoft SQL server database user for |dentity Management component" on page 19

« "Create Microsoft SQL Server filegroup with embedded HP Operations Orchestration" on page 20

Enable TCP/IP on Microsoft SQL server

TCP/IP must be enabled on the Microsoft SQL Server for HP Codar to access the database. By
default, TCP/IP may be disabled on the Microsoft SQL Server. Verify the TCP/IP configuration.

From the SQL Server Configuration Manager, complete the following steps:
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1. Select SQL Server Network Configuration > Protocols for <instance_name>.
2. Double-Click TCP/IP to open the TCP/IP Properties dialog.
3. From the TCP/IP Properties dialog, select the IP Addresses tab.

4. Verify that TCP/IP is active and enabled, and verify that the TCP port is set to 1433. Update any
properties that are not set correctly.

Configure Microsoft SQL server database user for HP Codar

An HP Codar database user is needed when installing HP Codar.

Caution: On Windows, the database name and user name cannot contain more than one dollar
sign symbol ($). For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

To create a database user for HP Codar, complete the following steps:

1. Create a new database for HP Codar (for example, codardb)

Caution: Use the default database option collation value of SQL_Latinl General CP1 CI
AS.

Do NOT use the collation value SQL_Latinl General CP1_CS_AS. HP Codar does not work
with a database that is configured with this collation value.

2. Add adatabase user (for example, codardbuser) with the following roles:
m db_datareader
m db_datawriter
m db_owner

You must provide this user name and password when prompted for the HP Codar database user during
the installation of HP Codar.

Configure Microsoft SQL reporting database role and read-only user
for HP Codar (required for reporting)

If you are using both the HP Cloud Service Automation and HP Codar licenses, you can use the HP
Cloud Service Automation reporting capabilities. If you want to use the reporting capabilities, you must
add a Microsoft SQL reporting database role and read-only user when installing HP Codar. For details
about the HP Cloud Service Automation reporting capabilities, see the HP Cloud Service Automation
Reporting and Auditing Whitepaper.
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Note: You must be using both the HP Cloud Service Automation and HP Codar licenses to use
the reporting capabilities.

Caution: On Windows, the database name and user name cannot contain more than one dollar
sign symbol ($). For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

Add a reporting database user to the HP Codar database with no roles.

For example, run the following commands to create the CODARReportingDBUser read-only user:

CREATE LOGIN CODARReportingDBUser WITH PASSWORD = '<codarreportingdbuser_
password>" ;
CREATE USER CODARReportingDBUser FOR LOGIN CODARReportingDBUser WITH DEFAULT_SCHEMA

= codar;

If you configure this user, you must provide this user's user name and password when prompted for the
HP Codar reporting database user during the installation of HP Codar.

Configure Microsoft SQL server database user for embedded HP
Operations Orchestration

An HP Operations Orchestration database user for embedded HP Operations Orchestration is needed
when installing HP Codar.

Caution: On Windows, the database name and user name cannot contain more than one dollar
sign symbol ($). For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

To create an HP Operations Orchestration database user for HP Codar, complete the following steps:
1. Create a new database for HP Operations Orchestration.

As of the release date of the HP Codar software (found at the beginning of this guide), the
mandatory database options for the Microsoft SQL Server for HP Operations Orchestration are:

Allow Snapshot Isolation: True

Is Read Committed Snapshot On: True

Auto Shrink: False

Auto Create Statistics: True

Caution: You should verify the latest mandatory options and follow the instructions in the HP
Operations Orchestration Database Guide when creating the HP Operations Orchestration
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database.

Note: HP Operations Orchestration recommends using the database option collation value of
SQL_Latinl General CP1_CS_AS. When creating the database used by HP Operations
Orchestration, this collation value is valid.

2. Add an HP Operations Orchestration database user with the following roles:
m db_datareader
m db_datawriter
m db_owner

You must provide this user name and password when prompted for the HP Operations Orchestration
database user during the installation of HP Codar.

Configure Microsoft SQL server database user for |dentity
Management component

An ldentity Management component database user is needed when installing HP Codar.

Caution: On Windows, the database name and user name cannot contain more than one dollar
sign symbol ($). For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

To create an ldentity Management component database user for HP Codar, complete the following
steps:

1. Create a new database for the Identity Management component (for example, codaridmdb).

Caution: Use the default database option Collation value of SQL_Latinl_General CP1 C1
AS.

Do NOT use the collation value SQL_Latinl General CP1 CS_AS. HP Codar does not work
with a database configured with this collation value.

2. You can use the existing database user you created for the HP Codar database (for example,
codardbuser) or you may create a new database user for the Identity Management component
database (for example, codaridmdbuser). If you create a new user, add an Identity Management
component database user with the following roles:

m db_datareader

m db _datawriter

HP Codar (1.50) Page 19 of 85



Installation and Configuration Guide
Install and initially configure database

m db_owner

You must provide this database user name and, user's password when prompted for the Identity
Management component database information during the installation of HP Codar.

Create Microsoft SQL Server filegroup with embedded HP
Operations Orchestration

If you chose to install embedded HP Operations Orchestration, for performance reasons, HP
recommends that you associate a new filegroup with the CSA_DOCUMENT table. Work with the database
administrator to configure a filegroup to be used by HP Codar (or see the manufacturer's documentation
for more information). HP recommends that the initial filegroup size should be at least 3 GB.

The filegroup is configured after HP Codar is installed.

PostgreSQL

You must complete the following installation and configuration steps if you wish to use PostgreSQL
with HP Codar.

"Install PostgreSQL" below

"Configure PostgreSQL users and database" below

Install PostgreSQL

Install the database according to the manufacturer's documentation. Database installation is typically
done in partnership with a database administrator.

See the HP Codar System and Software Support Matrix for a list of supported database versions.

Configure PostgreSQL users and database

The following tasks must be completed before HP Codar is installed. Work with the database
administrator to complete the following tasks (or see the manufacturer's documentation for more
information).

At least two database users are needed when installing HP Codar.

To configure PostgreSQL users and database, complete the following steps.

1. Onthe system hosting the database, install postgres-client ifitis not already installed. As the
root user, enter the following:

Windows and Linux Ubuntu:
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apt-get install postgresql-client
Linux Red Hat Enterprise
rpm ivh postgres-client.rpm
2. ForLinux Red Hat Enterprise, set the shared library path to include the PostgreSQL libraries
(<postgresql_installation>/1ib). For example, if you installed PostgreSQL in
/opt/PostgreSQL/9.2/, run the following command:
export LD_LIBRARY_PATH=/opt/PostgreSQL/9.2/1ib:$LD_LIBRARY_PATH
3. Logintopsqgl asthe postgres user.
a. Enterthe following:
psql -h localhost -U postgres -d templatel

b. When prompted, enter the password for the postgres user.

4. Create an HP Codar database user (for example, codardbuser). The HP Codar database user is
required. This user should inherit rights from parent roles and be a superuser.

Caution: On Windows, the user name cannot contain more than one dollar sign symbol ($).
For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

From the psql prompt, enter the following:

create role codardbuser login password '<codardbuser_password>' superuser
inherit;

This is the user to whom you will grant access to the HP Codar database when you create this
database.

5. ForWindows and Linux Red Hat Enterprise, create an HP Operations Orchestration database
user (for example, codaroodbuser). The HP Operations Orchestration database user, used by the
embedded HP Operations Orchestration, is required. This user should inherit rights from parent
roles and be a superuser.

Caution: On Windows, the user name cannot contain more than one dollar sign symbol ($).
For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

From the psql prompt, enter the following:

create role codaroodbuser login password '<odaroodbuser password>' superuser
inherit;
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This is the user to whom you will grant access to the HP Operations Orchestration database when
you create this database.

6. Optionally, create an Identity Management component database user (for example,
codaridmdbuser). This user should inherit rights from parent roles and be a superuser.

Caution: On Windows, the user name cannot contain more than one dollar sign symbol ($).
For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

From the psql prompt, enter the following:

create role codaridmdbuser login password '<codarimdbuser _password>' superuser
inherit;

This is the user to whom you will grant access to the Identity Management component database
when you create this database. If you do not create this user, you can use the HP Codar database
user (for example, codardbuser) instead.

7. Optionally, create a reporting database user for HP Codar (for example, CODARReportingDBUser).
A reporting database user is needed only if you want to use the reporting capabilities of HP Cloud
Service Automation, and you are using both the HP Cloud Service Automation and HP Codar
licenses. For details about the HP Cloud Service Automation reporting capabilities, see the HP
Cloud Service Automation Reporting and Auditing Whitepaper. This user should have read-only
rights.

Note: You must be using both the HP Cloud Service Automation and HP Codar licenses to
use the reporting capabilities.

Caution: On Windows, the user name cannot contain more than one dollar sign symbol ($).
For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

From the psql prompt, enter the following:

create role CODARReportingDBUser login password

' <CODARReportingDBUser_password>' nosuperuser nocreatedb nocreaterole

inherit;

If you configure this user, you must provide this user's user name and password when prompted
for the HP Codar reporting database user during the installation of HP Codar.

8. Create a new database for HP Codar. Grant the HP Codar database user all rights to this
database. If you added a reporting database user in step 7, grant the reporting database user read-
only access to this database.
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Caution: On Windows, the user name cannot contain more than one dollar sign symbol ($).
For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

For example, if you create a database named codardb, an HP Codar user named codardbuser,
and a reporting database user CODARReportingDBUser, from the psql prompt, enter the following
commands:

create database codardb with owner=codardbuser connection limit=-1;
grant all on database codardb to codardbuser;
grant connect on database codardb to CODARReportingDBUser;

You must provide this database name, database user name and, user's password when prompted
for the HP Codar database information during the installation of HP Codar.

9. ForWindows and Linux Red Hat Enterprise, create a new database for HP Operations
Orchestration. Grant the HP Operations Orchestration database user all rights to this database.
See the HP Operations Orchestration Database Guide for more information about database
requirements for HP Operations Orchestration.

Caution: On Windows, the user name cannot contain more than one dollar sign symbol ($).
For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

For example, if you create a database named codaroodb and an HP Operations Orchestration
user named codaroodbuser, from the psql prompt, enter the following commands:

create database codaroodb with owner=codaroodbuser connection limit=-1;
grant all on database codaroodb to codaroodbuser;

You must provide this database name, database user name and, user's password when prompted
for the HP Operations Orchestration database information during the installation of HP Codar.

10. Create a new database for the Identity Management component. Grant the Identity Management
component database user (if you configured this user) or HP Codar database user all rights to this
database.

Caution: On Windows, the user name cannot contain more than one dollar sign symbol ($).
For example, c$adb is a valid name but c$$adb and c$ad$b are not valid names.

For example, to create a database named codaridmdb granting access to the Identity
Management component database user named codaridmdbuser, from the psql prompt, enter the
following commands:

create database codaridmdb with owner=codaridmdbuser connection limit=-1;
grant all on database codaridmdb to codaridmdbuser;
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If you did NOT create an Identity Management component database user named
codaridmdbuser, create a database named codaridmdb and grant access to this database to the
HP Codar database user named codardbuser. From the psql prompt, enter the following
commands:

create database codaridmdb with owner=codardbuser connection limit=-1;
grant all on database codaridmdb to codardbuser;

You must provide this database name, database user name and, user's password when prompted
for the Identity Management component database information during the installation of HP Codar.

11. Exit psqgl. From the psql prompt, enter the following:

\q
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Install HP Operations Orchestration to the correct version and patch level. If you are using an existing
installation of HP Operations Orchestration, you should verify that the correct versions of patches and
updates have been applied. See the HP Codar System and Software Support Matrix for version

requirements.

If you are using an existing installation of HP Operations Orchestration, you should verify that the
correct versions of patches and updates have been applied.

Caution: HP Codar supports HP Operations Orchestration 10.21.0001. If you are using an earlier
version of HP Operations Orchestration, you must upgrade HP Operations Orchestration before

installing HP Codar. See the HP Codar Upgrade Guide for instructions.

Configure internal user

This internal user is used to configure HP Operations Orchestration for HP Codar. This step is required
if you are going to integrate HP Operations Orchestration with HP Codar using the installer.

To configure an internal user to configure HP Operations Orchestration, do the following:

1.

Log in to the existing HP Operations Orchestration Central.

2. Click the System Configuration button.
3. Select Security > Internal Users.
4. Click the Add (+)icon.
5. Enter the following information:
Field Recommended value
User Name admin
Password cloud
Roles ADMINISTRATOR, SYSTEM_ADMIN
6. Click Save.

7. Enable authentication by selecting Enable Authentication.

8. Click OK in the confirmation dialog.

HP Codar (1.50)
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Export HP Operations Orchestration root certificate

Export the HP Operations Orchestration certificate from the HP Operations Orchestration truststore.

If HP Operations Orchestration and HP Codar are not installed on the same system, copy the
certificate to the HP Codar system. This certificate will be imported into the HP Codar truststore by the
HP Codar installer. SSL must be configured between HP Codar and HP Operations Orchestration.

For example, do the following:

1.

On the system running HP Operations Orchestration, open a command prompt and change to the
directory where HP Operations Orchestration is installed.

Run the following command:

For HP Operations Orchestration 10.21 on Windows:
.\java\bin\keytool -export -alias tomcat -file C:\oo.crt -
keystore .\Central\var\security\key.store -storepass <password>

For HP Operations Orchestration 10.21 on Linux:
./java/bin/keytool -export -alias tomcat -file /tmp/oo.crt -
keystore ./Central/var/security/key.store -storepass <password>

where C:\oo.crt and /tmp/oo. crt are examples of file names and locations used to store the
exported root certificate (you can choose a different file name and location).

If HP Operations Orchestration is not running on the same system as HP Codar, copy oo.crt
from the HP Operations Orchestration system to the system running HP Codar.
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See the appropriate sections for instructions on installing HP Codar:

"Install HP Codar on Windows" below

"Install HP Codar on Linux" on page 36

« "Post-installation database configuration" on page 45

Install HP Codar on Windows

Note: Installation log files are written to the CSA_HOME\ _HP_Codar_1 50 0 _
installation\Logs\ folder.

Toinstall HP Codar, complete the following steps.

1.

Close all instances of Windows Explorer and command prompts and exit all programs that are
running on the system.

Unzip the setup. zip file. Go to the directory to which the files have been extracted and run the
setup.bat installation file.

On the Introduction screen, read the information and click Next.

Read the license agreement and select | accept the terms of the License Agreement. Click
Next to continue with the installation.

If the following error message is displayed, exit the installer:

Another version of HP Codar is configured in the registry. However, HP Codar
has been uninstalled (the HP Codar installation folder CSA HOME does not
exist). You must exit the installer and delete the entry in the registry before

installing HP Codar. See the HP Codar Installation and Configuration Guide for
more information about deleting the registry entry.

a. Locatethe C:\Program Files\Zero G Registry\.com.zerog.registry.xml file (you may
need to show hidden files).

b. Make a backup copy.
c. Delete all HP Codar entries from the . com. zerog.registry.xml file.

d. Restart the installer.
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5. Select HP Codar and click Next.
6. Choose alocation in which to install HP Codar and click Next (CSA_HOME is set to this location).

The default location is C: \Program Files\Hewlett-Packard\Codar.

Note: If the folder in which you choose to install HP Codar is not empty, existing content in
the folder may be overwritten or deleted when HP Codar is installed, upgraded, or uninstalled.

Caution: The entire folder path cannot contain more than one dollar sign symbol ($). For
example, C: \HP\C$A\Java and C: \HP\CSA\Java$ are valid paths. However
C:\HP\C$A\Java$ and C:\HP\C$$A\Java are not valid paths.

7. Choose the JRE that will be used by HP Codar.
In this documentation, the folder in which the JRE is installed is referred to as CSA_JRE_HOME.
For a list of supported JREs, see the HP Codar System and Software Support Matrix.

= OpenJDK JRE
The OpenJDK JRE is bundled with HP Codar. If you want to use the OpenJDK JRE, click
Open JRE and click Next.

The default location in which the OpenJDK JRE is installed is C: \Program Files\Hewlett-
Packard\Codar\openjre.

= Oracle JRE
If you have installed a supported version of Oracle JRE to be used by HP Codar, click Oracle
JRE, select the location in which you installed this JRE, and click Next.

The default location displayed for the Oracle JRE Home is either a supported JRE that is
configured in the system registry or a supported JRE in a path that is defined in the system
path variable.

If this is not the JRE that should be used by HP Codar, click Choose and select the location in
which you installed the JRE that will be used by HP Codar.

Caution: The entire folder path cannot contain more than one dollar sign symbol ($).

8. Install HP Codar database components onto the database instance to create the database
schema, if it does not exist.

Click Yes to install HP Codar database components and create the database schema. When you
select this option, the HP Codar service automatically starts when you exit the installer.
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10.

Click No if you are using an existing HP Codar database schema that was created as part of a
prior successful installation of HP Codar version 1.50. When you select this option, the HP Codar
service does not start when you exit the installer. See the end of this section for information on
how to start the HP Codar service.

Select the type of database installed (Oracle, Microsoft SQL, or PostgresSQL) and click Next.

For an Oracle database, you must also enter the JDBC Driver Directory. This is the absolute
folder path to the location of the JDBC drivers (these are the JDBC drivers you downloaded onto
the HP Codar system). For a list of supported JDBC driver versions, see the HP Codar System
and Software Support Matrix.

Caution: The entire folder path cannot contain more than one dollar sign symbol ($).

Define the database instance on which the HP Codar database components should be installed or
where the HP Codar database schema already exists. Separate database instances are required
for HP Codar and the components it uses. You must create a separate database instance for:

» Embedded HP Operations Orchestration
= |dentity Management component
m HP Codar

Enter the following database information and click Next.

Field Description

<database_type> Database Host The host name or IP address of the server where
the database is located. When specifying an IPv6
address, it must be enclosed in square brackets.
For example, [f000:253c::9c10:b4db4d] or [::1].

<database_type> Database Port The database port number, such as 1433 (Microsoft
SQL Server), 1521 (Oracle), or 5432 (PostgreSQL).
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Field Description
HP Codar Database Name/Oracle The name of the database instance on which the
service name HP Codar database schema will be installed.

= [f you are creating a new HP Codar database
schema, this is the name of the database
instance on which the HP Codar database
components will be installed.

= |f you are using an existing HP Codar database
schema that was created as part of a prior
successful installation of HP Codar version
1.50, this is the name of the database instance
on which the HP Codar database schema
exists.

m For an Oracle database, this is the service

name.
HP Codar Database User Name The user name of the database user you configured
for HP Codar in the database (for example,
codardbuser).
HP Codar Database Password The password for the database user.

11. If you created a reporting database role and read-only user when you configured the HP Codar
database, select Reporting User and enter the following information:

Note: You must be using both the HP Cloud Service Automation and HP Codar licenses to
use the HP Cloud Service Automation reporting capabilities. For details, see the HP Cloud
Service Automation Reporting and Auditing Whitepaper.

Field Description
HP Codar Reporting The user name of the database user you configured for reporting
Database User Name purposes for HP Codar. For details on configuring the reporting

database user, see one of these sections, depending on which
database you installed: "Configure Oracle Database" on page 10,
"Configure Microsoft SQL Server" on page 16, or "Configure
PostgreSQL users and database" on page 20.

HP Codar Reporting This is the password for the HP Codar reporting database user.
Database User Password

12. Enter the database information for the database used by the Identity Management component and
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click Next. The database used by the Identity Management component must be the same type of
database used by HP Codar. Enter the following database information.

Field Description

<database_type> Database Host The host name or IP address of the server where
the Identity Management component database is
located.

<database_type> Database Port The ldentity Management component database port

number, such as 1433 (Microsoft SQL Server), 1521
(Oracle), or 5432 (PostgreSQL).

HP ldentity Management Database The name of the database instance used by the

Name/Oracle service name Identity Management component. For example,
codaridmdb. For an Oracle database, this is the
Oracle service name.

HP Identity Management Database User = The user name of the database user you configured

Name for the Identity Management component database
(for example, codaridmdbuser or codardbuser).
For details on configuring the Identity Management
component database user, see one of these
sections, depending on which database you
installed: "Configure Oracle Database" on page 10,
"Configure Microsoft SQL Server" on page 16, or
"Configure PostgreSQL users and database" on

page 20.
HP Identity Management Database The password for the Identity Management
Password component database user.

13. From the Enter host name screen, enter the fully-qualified domain name of the system on
which you are installing HP Codar. The fully-qualified domain name is used to generate the
self-signed SSL certificate which is used when https browser requests are issued for HP Codar.
This self-signed certificate expires 120 days after HP Codar is installed.

Caution: If you enter an IP address, after installation completes, you must manually generate
a self-signed certificate using the fully-qualified domain name of the system on which you
installed HP Codar and manually reconfigure HP Codar to use this certificate. For more
information, see the HP Codar Configuration Guide.

14. By default, HP Single Sign-On (SSO) is included with HP Codar and is enabled. The HP Single
Sign-On that is included can only be used when launching an application, such as HP Operations
Orchestration, from the HP Codar Console. See the HP Single Sign-On documentation for more
information on integrating HP Single Sign-On with an application.
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15.

16.

17.

If you do not want to use HP Single Sign-On, you can disable it by selecting Disable HP SSO.

If enabled, enter the domain name of the network to which the server on which you are installing
HP Codar belongs and click Next.

Note: You must enter the full domain name of the server. For example, if you are installing HP
Codar on a system whose fully-qualified domain name is machinel.development.xyz.com,
you must enter development.xyz.com. If you enter only xyz.com, you will not be able to log
in to the HP Codar Console.

Applications launched from the HP Codar Console with which you want to use HP Single Sign-On
must be installed on systems that belong to this domain.

Specify whether you want to install the embedded (new) HP Operations Orchestration instance
with HP Codar or if you are integrating with an external (existing) instance of HP Operations
Orchestration:

= Toinstall the embedded HP Operations Orchestration, select Install embedded HP OO and
click Next. Proceed to Steps 16 - 18.

m Tointegrate with an external (existing) instance of HP Operations Orchestration, select Use
external HP OO and click Next. Proceed to Step 19.

If you chose to install the embedded HP Operations Orchestration, choose a location and click
Next.

Configure an internal HP Operations Orchestration user and click Next. This user is used for
provisioning topology designs.

Field name Description

HP Operations Orchestration User Name = The name of the user used for provisioning topology
designs. This user is given the ADMINISTRATOR
and SYSTEM_ADMIN roles. The recommended
user name is admin.

HP Operations Orchestration Password = The password used by HP Operations
Orchestration for the user who provisions topology
designs. The recommended password is cloud.

HP Codar (1.50) Page 32 of 85



Installation and Configuration Guide
Install HP Codar

Field name

HP Operations Orchestration Port

Description

The embedded HP Operations Orchestration port
number, such as 8445, used to access HP
Operations Orchestration Central. By default, HP
Operations Orchestration uses this port and port
8080. Applications running on the system on which
HP Codar and the embedded HP Operations
Orchestration are installed should not be using
these ports.

18. Enter the database information for the database used by the embedded HP Operations
Orchestration and click Next. The database used by the embedded HP Operations Orchestration
must be the same type of database used by HP Codar.

19.

Field name

<database_type>
Database Host

<database_type>
Database Port

HP Operations
Orchestration
Database Name or
Oracle HP
Operations
Orchestration SID

HP Operations
Orchestration
Database User
Name

HP Operations
Orchestration
Database
Password

Description

The hostname or IP address of the server where the embedded HP
Operations Orchestration database is located. When specifying an IPv6
address, it must be enclosed in square brackets. For example,
[fe00:253c::9cl10:bdb4] or[::1].

The embedded HP Operations Orchestration database port number, such
as 1433 (Microsoft SQL Server), 1521 (Oracle), or 5432 (PostgreSQL).

The name of the database instance used by the embedded HP Operations
Orchestration. For an Oracle database, this is the service name.

The user name of the database user you configured for the HP Operations
Orchestration database. See one of these sections, depending on which
database you installed: "Configure Oracle Database" on page 10,
"Configure Microsoft SQL Server" on page 16, or "Configure PostgreSQL
users and database" on page 20.

The password for the HP Operations Orchestration database user.

If you chose to integrate with an external (existing) HP Operations Orchestration, define the

existing HP Operations Orchestration instance with which HP Codar is to be integrated. Enter the
following information (select Enter after each entry) and click Next when done.
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Field

HP Operations Orchestration Hostname

HP Operations Orchestration Port

HP Operations Orchestration User

HP Operations Orchestration Password

HP Operations Orchestration Certificate
File

HP Codar (1.50)

Description

The fully-qualified domain name or IP address of the
server where HP Operations Orchestration is
located. Specify the hostname that was used to
generate HP Operations Orchestration's certificate.
The hostname is used for SSL validation and to
build the URL that the HP Codar Console uses to
interact with HP Operations Orchestration. (For
example, in the subscription event overview section
of the Operations area in HP Codar, selecting the
Process ID opens HP Operations Orchestration to
the detailed page of the selected process when
these properties are configured).

When specifying an IPv6 address, it must be
enclosed in square brackets. For example,
[f000:253c::9cle:bdb4] or [::1].

The port number used to communicate with HP
Operations Orchestration, such as 8445. By default,
HP Operations Orchestration uses this port and port
8080.

Caution: Ensure that port 8080 is not being
used on the system where you install HP
Codar and the embedded HP Operations
Orchestration. If this port is used, then HP
Operations Orchestration flows will not work

properly.

The name of the user who logs in to HP Operations
Orchestration Central. HP recommends that you
use the admin user you defined in "Install external
HP Operations Orchestration" on page 25.

The password used to log in to HP Operations
Orchestration Central.

The file name and location of HP Operations
Orchestration's certificate from HP Operations
Orchestration's truststore on the HP Codar system.
If you have not already done so, export HP
Operations Orchestration's certificate and copy it to
the HP Codar system.
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20.

21.

22.

23.

24,

Note: This information is used to set the HP Operations Orchestration properties in the
csa.properties file and import HP Operations Orchestration's certificate into HP Codar's
truststore.

By default, sample content (service designs and the components and HP Operations
Orchestration flows required by the designs) are installed with HP Codar. You can choose to
deploy this content during installation (making the sample service designs available in the Designs
are of the HP Codar Console) or deploy the content at a later time.

To deploy the sample content during the HP Codar installation process, select Install sample
content and click Next.

To deploy the sample content at a later time, select Skip content installation and click Next.
If you choose to skip content installation, you can install the content at a later time, by running the

HP Cloud Content Capsule Installer. For details, see the HP Cloud Service Automation Content
Pack User Guide.

Note: If you chose not to install the database components, this dialog will not display.

Review your selections and click Install to complete the installation.

You may be asked to restart your system.

Click Yes, restart my system to restart your system when you exit the installer.

Click No, I will restart my system myself to restart your system at a more convenient time.
Click Done to exit the installer.

Verify that the HP Codar and HP Operations Orchestration services have started by navigating to
Start> Administrative Tools > Services. The service may take up to five minutes to start.

If the service has not started, right-click on the service and select Start.

The installer creates the HP Codar services. If you opted to install the HP Codar database
components, the installer also starts these services. The HP Codar service must be running
before you can access the HP Codar Console.
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Configure group and user

To configure a group and user for HP Codar, complete the following steps:
1. Loginto the system as the root user.
2. Create a group called codargrp. Enter the following:

addgroup codargrp (Ubuntu)
groupadd codargrp (Red Hat Enterprise Linux)

3. Create a user called codaruser and assign this user to the codargrp. Enter the following:

adduser -g codargrp -m codaruser (Ubuntu)
useradd -g codargrp -m codaruser -s /bin/bash (Red Hat Enterprise Linux)

4. Assign a password to the codaruser. Enter the following:
passwd codaruser

When prompted, enter the password.

Install HP Codar

Note: Installation log files are written to the CSA_HOME/ HP_Codar_1 56 @ installation/Logs/
directory and are named codar_*.txt.

Toinstall HP Codar on Linux, complete the following steps.
1. Loginto the system as the root user.
2. Create an installation directory for HP Codar (this document assumes that you will install the
product in /usr/local/hp/codar and all examples used in this document are based on this
assumption). Enter the following:

mkdir -p /usr/local/hp/codar

3. Forthe installation directory, set the owner to codaruser and the group to codargrp. Enter the
following:

chown -R codaruser:codargrp /usr/local/hp/codar
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10.

1.

Log out as the root user and log in as codaruser.

Copy the HP Codar installation file, setup-codar.bin, the system and go to the directory in
which it has been copied.

Verify that setup-codar.bin is owned by codaruser and that codaruser has full permissions for
the file. If necessary, complete the following steps:

a. Login as the root user
b. Enterone or both of the following commands:

chown codaruser setup-codar.bin
chmod u+rwx setup-codar.bin

c. Logout as the root user and log in as codaruser.

Check the values of the CSA_HOME, PS1, and TITLEBAR environment variables. If they are set,
verify that they do not contain any escape sequences. If any of these variables contain an escape
sequence, the variable will cause the installer to fail. The variable must either be reset to a value
that does not contain an escape sequence or must be unset.

Run the setup-codar.bin installation file.

Note: You must run setup-codar.bin as the codaruser. If you install as another user, you
may not be able to run HP Codar.

As the codaruser, enter the following:

./setup-codar.bin

Read the Introduction and press Enter to continue with the installation.

Read the license agreement. Press Enter to scroll through the entire agreement.

Select Y and Enter to accept the license agreement and continue with the installation. Select N
press Enter to exit the installation.

If the following error message displays, exit the installer:

Another version of HP Codar is configured in the registry. However, HP Codar
has been uninstalled (the HP Codar installation directory CSA HOME does not
exist). You must exit the installer and delete the entry in the registry before
installing HP Codar. See the HP Codar Installation and Configuration Guide for
more information about deleting the registry entry.

a. Locate the $HOME/.com.zerog.registry.xml file (for example,
/home/codaruser/.com.zerog.registry.xml).
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b. Make a backup copy.
c. Delete all HP Codar entries from the . com. zerog.registry.xml file.
d. Restart the installer.

12. Select HP Codar and press Enter.

13. Enteralocation in which to install HP Codar (enter the absolute path to the location) and press
Enter. Or, press Enter to accept the default location.

The default location is /usr/local/hp/codar.

Note: If the directory in which you choose to install HP Codar is not empty, existing content
in the directory may be overwritten or deleted when HP Codar is installed, upgraded, or
uninstalled.

If prompted, verify the installation folder. If the folder is correct, select Y and Enter to continue
with the installation. If the folder is not correct, select N and Enter to re-enter the installation
folder.

14. Choose the JRE that will be used by HP Codar.

In this documentation, the directory in which the JRE is installed will be referred to as CSA_JRE_
HOME.

For a list of supported JREs, see the HP Codar System and Software Support Matrix.
OpenJDK JRE

The OpenJDK JRE is bundled with HP Codar. If you want to use the OpendJDK JRE, type 1 and
press Enter.

The default location in which the OpenJDK JRE is installed is /usr/local/hp/codar/openjre.
Oracle JRE

If you have installed a supported version of Oracle JRE to be used by HP Codar, type 2 and press
Enter. Type the location in which you installed this JRE and press Enter.

The default location displayed for the Oracle JRE Home is either a supported JRE that is
configured in the system registry or a supported JRE in a path that is defined in the system path
variable. If this is not the JRE that should be used by HP Codar, type in the location in which you
installed the JRE that will be used by HP Codar and press Enter.

Proceed to Step 26 for instructions on configuring Oracle JRE.

15. Install HP Codar database components onto the database instance to create the HP Codar
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database schema, if it does not already exist.

Type yes to install HP Codar database components and create the HP Codar database schema.
When you select this option, the HP Codar process automatically starts when you exit the
installer.

Type no if you are using an existing HP Codar database schema that was created as part of a
prior successful installation of HP Codar version 1.50. When you select this option, the HP Codar
process does not start when you exit the installer. See the end of this section for information on
how to start and stop the HP Codar service.

16. Define the database instance on which the HP Codar database components should be installed.
Enter the following database information (press Enter after each entry).

a. Enterthe type of database you have installed: MSSql (Microsoft SQL Server), Oracle, or
Postgres (PostgreSQL).

For an Oracle database, you must also enter the JDBC Driver Directory. This is the absolute
directory path to the location of the JDBC drivers (these are the JDBC drivers you
downloaded onto the HP Codar system). For a list of supported JDBC driver versions, see the
HP Codar System and Software Support Matrix.

b. Enter the database hostname. This is the hostname or IP address of the server where the
database is located. When specifying an IPv6 address, it must be enclosed in square
brackets. For example, [f000:253c::9c10:b4b4] or [ : :1]. The default value is the IP
address of the localhost (127.0.0.1).

c. Enterthe database port. This is the database port number, such as 1433 (Microsoft SQL
Server), 1521 (Oracle), or 5432 (PostgreSQL).

d. Enterthe database name. This is the name of the database instance on which the HP Codar
database schema will be installed.

If you are creating a new HP Codar database schema, this is the name of the database
instance on which the HP Codar database components will be installed.

If you are using an existing HP Codar database schema that was created as part of a prior
successful installation of HP Codar version 1.50, this is the name of the database instance on
which the HP Codar database schema already exists.

If you followed the examples in this document, enter codardb.

e. Enterthe Codar database user name. This is the user name of the database user you
configured for HP Codar in the appropriate database configuration section of this guide.

If you followed the examples in this document, enter codardbuser.

f. Enter the Codar database password. This is the password for the Codar database user.
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g.

h.

Enter the HP Codar reporting database user name (optional). This is the user name of the
database user you configured for reporting purposes for HP Codar. For details on configuring
the reporting database user, see one of these sections, depending on which database you
installed: "Configure Oracle Database" on page 10, "Configure Microsoft SQL Server" on
page 16, or "Configure PostgreSQL users and database" on page 20.

Enter the password for the HP Codar reporting database user.

Note: You must be using both the HP Cloud Service Automation and HP Codar licenses to
use the HP Cloud Service Automation reporting capabilities. For details, see the HP Cloud
Service Automation Reporting and Auditing Whitepaper.

17. Provide the database instance used by the Identity Management component. Enter the following
database information (press Enter after each entry).

18.

a.

Enter the database hostname. The host name or IP address of the server where the
database is located. When specifying an IPv6 address, it must be enclosed in square
brackets. For example, [f000:253c::9c10:b4b4]or[::1].

Enter the database port. This is the database port number, such as 1433 (Microsoft SQL
Server), 1521 (Oracle), or 5432 (PostgreSQL).

Enter the Identity Management component Database Name/Oracle SID. The name of the
database instance used by the Identity Management component.

Enter the Identity Management component database user name. This is the user name of
the database user you configured for the Identity Management component database. For
details on configuring the Identity Management component database user, see one of these
sections, depending on which database you installed: "Configure Oracle Database" on

page 10, "Configure Microsoft SQL Server" on page 16, or "Configure PostgreSQL users and
database" on page 20.

Enter the Identity Management component database password. This is the password for
the Identity Management component database user.

Enter the HP Codar server host name. This is the fully-qualified domain name of the system
on which you are installing HP Codar. The fully-qualified domain name is used to generate the
self-signed SSL certificate which is used when https browser requests are issued for HP Codar.
This self-signed certificate expires 120 days after HP Codar is installed.

Caution: If you enter an IP address, after installation completes, you must manually generate
a self-signed certificate using the fully-qualified domain name of the system on which you
installed HP Codar and manually reconfigure HP Codar to use this certificate.

19. By default, HP Single Sign-On (HP SSO) is included with HP Codar and is enabled. The HP
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Single Sign-On that is included with HP Codar can only be used when launching an application,
such as HP Operations Orchestration or HP IT Executive Scorecard, from the HP Codar Console.
See the HP Single Sign-On documentation for more information on integrating HP Single Sign-On
with an application.

If you do not want to use HP Single Sign-On, you can disable it. Type 2 and select Enter.

To enable HP Single Sign-On, type 1 and select Enter. Enter the Domain name of the network to
which the server belongs (the server on which you are installing HP Codar) and select Enter.

Note: You must enter the full domain name of the server. For example, if you are installing HP
Codar on a system whose fully-qualified domain name is machinel.marketing.xyz. com,
you must enter marketing.xyz . com. If you enter only xyz.com, you will not be able to log in to
the HP Codar Console.

Applications launched from the HP Codar Console with which you want to use HP Single Sign-On
must be installed on systems that belong to this domain.

20. Specify whether you want to install the embedded (new) HP Operations Orchestration instance
with HP Codar or if you are integrating with an external (existing) instance of HP Operations
Orchestration.

= Select 1 and Enter to integrate with an external (existing) instance of HP Operations
Orchestration. Proceed to Step 20a.

= Select 2 and Enter to install the embedded HP Operations Orchestration. Proceed to Step 20b.

a. If you are integrating with an external (existing) HP Operations Orchestration, define the HP
Operations Orchestration instance with which HP Codar is to be integrated. Enter the
following information (press Enter after each entry). Proceed to step 21.

i. Enterthe HP Operations Orchestration host name. This is the fully-qualified domain
name or |P address of the server where HP Operations Orchestration is located. Specify
the hostname that was used to generate the HP Operations Orchestration certificate.
The hostname is used for TLS validation and to build the URL that the HP Codar
Console uses to interact with HP Operations Orchestration (for example, in the
subscription event overview section of the Operations area in the HP Codar Console,
selecting the Process ID opens HP Operations Orchestration to the detailed page of the
selected process when these properties are configured).

ii. Enterthe HP Operations Orchestration port. This is the port number used to
communicate with HP Operations Orchestration, such as 8445. The port number is used
to build the URL that the HP Codar Console uses to interact with HP Operations
Orchestration. By default, HP Operations Orchestration uses this port and port 8080.
Applications running on the system on which HP Operations Orchestration is installed
should not be using these ports.
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Vi.

Caution: Ensure that port 8080 is not being used on the system where you install
HP Codar and the embedded HP Operations Orchestration. If this port is used, then
HP Operations Orchestration flows will not work properly.

Enter the HP Operations Orchestration user. This is the name of the user who logs in
to HP Operations Orchestration Central. HP recommends that you use the admin user.
If you followed all the steps documented in "Install external HP Operations
Orchestration" on page 25, this is the admin user.

Enter the HP Operations Orchestration password. This is the password used to log in
to HP Operations Orchestration Central. If you followed all the steps documented in
"Install external HP Operations Orchestration" on page 25, use the password cloud

Re-enter the HP Operations Orchestration password.

Enter the HP Operations Orchestration certificate file. This is the file name and
location of HP Operations Orchestration's certificate from HP Operations
Orchestration's truststore on the HP Codar system. If you have not already done so,
export the HP Operations Orchestration certificate and copy it to the HP Codar system
(see "Install external HP Operations Orchestration" on page 25 for more information).

Note: This information is used to set the HP Operations Orchestration properties in the
csa.properties file and to import HP Operations Orchestration's certificate into

HP Codar's truststore. See HP Codar Configuration Guide for more information about
these properties.

b. If you are installing embedded HP Operations Orchestration, enter a location and press Enter.

HP Codar (1.50)

Enter the database information for the database used by the embedded HP Operations
Orchestration (press Enter after each entry). The database used by the embedded HP
Operations Orchestration must be the same type of database used by the HP Codar
(Microsoft SQL Server, Oracle, or PostgreSQL).

A. Enterthe database hostname. This is the hostname or IP address of the server
where the embedded HP Operations Orchestration database is located. When
specifying an IPv6 address, it must be enclosed in square brackets. For example,
[f000:253c::9cl0:bdb4] or [::1].

B. Enterthe database port. This is the embedded HP Operations Orchestration
database port number, such as 1433 for Microsoft SQL Server, 1521 for Oracle, or
5432 for PostgreSQL.

C. Enterthe HP Operations Orchestration database name or Oracle HP
Operations Orchestration SID. This is the name of the database instance used
by the embedded HP Operations Orchestration. For an Oracle database, this is the
Oracle service name.
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21.

22

23.

24,

25.

D. Enterthe HP Operations Orchestration database user name. This is the user
name of the database user you configured for the HP Operations Orchestration
database.

E. Enterthe HP Operations Orchestration database password. This is the password
for the HP Operations Orchestration database user.

F. Enterthe embedded HP Operations Orchestration port number, such as 8445.
By default, HP Operations Orchestration uses this port and port 8080. Applications
running on the system on which HP Codar and the embedded HP Operations
Orchestration are installed should not be using these ports.

ii. Configure an internal HP Operations Orchestration user (press Enter after each entry).
This user is used for provisioning topology designs.

A. Enterthe HP Operations Orchestration user name. This is the name of the user
used for provisioning topology designs. This user is given the ADMINISTRATOR
and SYSTEM_ADMIN roles. The recommended user name is admin.

B. Enterthe HP Operations Orchestration password. This is the password used by
HP Operations Orchestration for the user who provisions topology designs. The
recommended password is cloud.

By default, sample content (service designs and the components and HP Operations
Orchestration flows required by the designs) are installed with HP Codar. You can choose to
deploy this content during installation (making the sample service designs available in the Designs
are of the HP Codar Console) or deploy the content at a later time.

To deploy the sample content during the HP Codar installation process, type 1 (Install sample
content) and press Enter.

To deploy the sample content at a later time, type 2 (Skip content installation) and press Enter.
If you choose to skip content installation, you can install the content at a later time, by running the
HP Cloud Content Capsule Installer. For details, see the HP Cloud Service Automation Content

Pack User Guide.

Review your selections and press Enter to complete the installation or Ctrl-C to exit the
installation.

When the installation completes, press Enter to exit the installer.

If you selected to use the OpenJDK JRE with HP Codar and installed HP Codar on a system
running a headless Ubuntu Linux version 14, install the Standard Java or Java-compatible
Runtime package. Enter the following:

apt-get install default-jre

Define the CSA_HOME and JAVA_HOME environment variables and add /sbin to the PATH variable
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26.

27.

28.

29.

for the codaruser user. Set CSA_HOME to the location where HP Codar is installed. In a startup
script for the codaruser user (for example, .profile (Ubuntu)or .bash_profile (Red Hat
Enterprise Linux)), add the following:

export CSA_HOME=/usr/local/hp/codar
export JAVA HOME=CSA_JRE_HOME
export PATH=$PATH:/sbin

where CSA_JRE_HOME is the directory where the JRE used by HP Codar is installed.
Source the startup file in which you set the CSA_HOME, JAVA_HOME, and PATH environment
variables. If you edited .bashrc (Ubuntu) or .bash_profile (Red Hat Enterprise Linux), enter the

following:

./ .bashrc (Ubuntu)
./.bash_profile (Red Hat Enterprise Linux)

Create an HP Codar service to start and stop the HP Codar processes.
a. Login as the root user.
b. Go to the directory in which HP Codar is installed. For example:
cd /usr/local/hp/codar
c. Copy the codar script to the /etc/init.d directory. Enter the following:
cp ./scripts/codar /etc/init.d
d. Change permissions of the scripts. Enter the following:
chmod 755 /etc/init.d/codar
e. Logout as the root user.
Login as codaruser and start the HP Codar service. Enter the following:
service codar start
As codaruser, restart the HP Operations Orchestration Central service. Enter the following:

/usr/local/hp/codar/00/central/bin/central stop
/usr/local/hp/codar/00/central/bin/central start

The HP Codar service must be running in order to access HP Codar Console. You can use the
following commands:

service codar start -to start the Codar service

service codar restart -torestart the Codar service

service codar stop -to stop the Codar service

service codar status -to check the status of the Codar service
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The HP Operations Orchestration Central service must be running in order to access HP Operations
Orchestration Central. You can use the following commands:

/usr/local/hp/codar/00/central/bin/central start -to start the HP Operations Orchestration
service

/usr/local/hp/codar/00/central/bin/central stop. -to stopthe HP Operations Orchestration
service

Post-installation database configuration

The following steps are required for either Oracle or Microsoft SQL Server, after you have installed HP
Codar.

Configure Oracle tablespace

Configure the Oracle tablespace you created for HP Codar only if you are installing HP Codar for the
first time and there is no data in the CODAR_DOCUMENT table. The tablespace must have been
created before HP Codar is installed and then must be configured immediately after HP Codar is
installed (see "Configure Oracle Database" on page 10 for information on creating the Oracle
tablespace).

Work with the database administrator to perform the following (or see the manufacturer's
documentation for more information):

Modify the CODAR_DOCUMENT table such that LOB segments are stored in the tablespace. For
example:

ALTER TABLE CODAR_DOCUMENT
MOVE LOB(content)
STORE AS (TABLESPACE <new tablespace>);

Configure Microsoft SQL Server filegroup

Configure the Microsoft SQL server filegroup you created for HP Codar only if you are installing

HP Codar for the first time and there is no data in the CODAR_DOCUMENT table. The filegroup must
have been created before HP Codar is installed and then must be configured immediately after

HP Codar is installed (see "Configure Microsoft SQL Server" on page 16 for information on creating the
Microsoft SQL server filegroup).

Work with the database administrator to perform the following (or see the manufacturer's
documentation for more information):

1. Drop all constraints from the CODAR_DOCUMENT table.

2. Drop the CODAR_DOCUMENT table.

HP Codar (1.50) Page 45 of 85



Installation and Configuration Guide
Install HP Codar

3. Recreate the CODAR_DOCUMENT table and associate it with the filegroup.

4. Recreate the constraints for the CODAR_DOCUMENT table.
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The HP Codar solution includes a number of HP Operations Orchestration flows that perform HP Codar
operations.

« Ifyouinstalled embedded HP Operations Orchestration, see "Configure embedded HP Operations
Orchestration" below.

« Ifyouinstalled external HP Operations Orchestration, see "Configure external HP Operations
Orchestration" on page 53.

Configure embedded HP Operations Orchestration

Complete the following tasks to configure the embedded HP Operations Orchestration to integrate
successfully with HP Codar (if you are configuring an exclusive stand-alone HP Operations
Orchestration, you do not need to complete these tasks):

« "Add JRE to the system path" on the next page
» "Configure internal users" on the next page
« "Deploy content packs required by HP Codar" on page 49
» "Verify deployed content packs" on page 50
« "Deploy HP Operations Orchestration and component tool content packs" on page 51
« "Set up system accounts for the HP Codar content pack" on page 52
« "Set up system properties for the HP Codar content pack" on page 53
« "Configure HP Single Sign-On" on page 53
Note: In the following instructions, CSA_HOME is the directory in which HP Codar is installed and

ICONCLUDE_HOME is where you installed HP Operations Orchestration.

Be sure all the latest patches for HP Operations Orchestration have been installed. See the HP
Codar System and Software Support Matrix for more information.
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Add JRE to the system path

The HP Codar flows that are imported require that a JRE be included in the system path on the system
running HP Codar.

To add a JRE to the system path on Windows, complete the following steps:

1. Open the Environment Variables dialog:
a. Right-click Computer and select Properties.
b. Select Advanced System Settings.
c. Click Environment Variables.

2. Select the Path system variable.

3. Click Edit.

4. Atthe end of the value for Variable value, add a semicolon (;) and the following path:
CSA_JRE_HOME\bin
where CSA_JRE_HOME is the directory in which the JRE used by HP Codar is installed. .

5. Click OK and close all windows.

To add a JRE to the system path on Linux, complete the following steps:
Open a shell and enter the following command:
export PATH=$PATH:CSA_ JRE_HOME/bin

where CSA_JRE_HOME is the directory in which the JRE used by HP Codar is installed.

Note: By setting the system path, all applications (that require a JRE) use the JRE that is installed
with HP Codar (if it is the only path or the first path set to a JRE in the system path). If you need to
run another JRE with an application, you must type in the relative path to that JRE in order to run it
(for example, when you configure SSL).

Configure internal users

Internal users can be used to configure HP Operations Orchestration for HP Codar.
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Note: The useris automatically added while installing Codar.

1. Loginto the existing HP Operations Orchestration central,
2. Click the System Configuration button.

3. Select Security > Internal Users.

4. Click the Add (+)icon.

5. Enter the following information:

Field Recommended value

User Name codaroouser

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN

The codaroouser user is used to import the HP Operations Orchestration flows. When importing
flows, this user is configured in the HP Operations Orchestration input file used by the process
definition tool.

6. Click Save.
7. Enable authentication by selecting the Enable Authentication check box.
8. Click OK in the confirmation dialog.

9. Log out of HP Operations Orchestration Central and log back in as the codaroouser.

Deploy content packs required by HP Codar

There are three sets of content packs that should be deployed for HP Codar: the base HP Operations
Orchestration content packs, the HP Codar component tool content packs, and the HP Codar content
pack.

The base HP Operations Orchestration and HP Codar component tool content packs were deployed
automatically when you installed HP Codar. If these content packs failed to deploy during installation,
you must deploy them manually.

Download the HP Codar HP Cloud Content Capsule using the HP Cloud Content Capsule Installer.
You can access the HP Cloud Content Capsule Installer from the CSA
HOME\tools\CSLContentInstaller directory afterinstalling HP Codar. The HP Codar content pack
must be deployed after the base HP Operations Orchestration content packs have been deployed. For
details about the HP Cloud Content Capsule Installer, see the HP Cloud Service Automation Content
Pack User Guide.
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Verify deployed content packs

To verify that the HP Operations Orchestration and component tool content packs were successfully
deployed during installation, complete the following steps:

1. Loginto HP Operations Orchestration Central.
2. Click the Content Management button.
3. Click the Content Packs tab.

4. Look for the names and versions of content packs in the list. If a content pack is missing, follow
the instructions below to manually deploy it.

The content packs that should have been automatically deployed are:
s CSA-HPOO

= CODAR

s EXISTING-INFRASTRUCTURE-WINDOWS
s CSA-VMWARE

s CSA-SITESCOPE

s CSA-SA

s CSA-HP-HELION-PUBLIC-CLOUD

m  CSA Chef Provisioner

= CSA-AMAZON

= SM

= SA

= Virtualization

= HP Solutions

= Cloud

= Base

s EXISTING-INFRASTRUCTURE

m CSA-Docker
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Deploy HP Operations Orchestration and component tool
content packs

If one or more of the base HP Operations Orchestration or HP Codar component tool content packs are
not deployed, you must deploy them manually.

To manually deploy the HP Operations Orchestration or HP Codar component tool content packs,
complete the following steps:

1.

2.

3.

4.

9.

Login to HP Operations Orchestration Central.

Click the Content Management button.

Click the Content Packs tab.

From HP Operations Orchestration Central, click the Content Management button.

Click the Content Packs tab.

Click the Deploy New Contenticon.

In the Deploy New Content dialog, click the Add files for deployment icon.

Navigate to the CSA_HOME\oo\0OOContentPack\ directory. From the subdirectories, select a
content pack and click Open then Deploy. Select, open, and deploy the following base content
packs in the order shown below:

m 0010-base-cp-1.4.4

m 0010-cloud-cp-1.4.0

m 0010-hp-solutions-cp-1.4.0

m 0010-virtualization-cp-1.4.0

m 0010-sa-cp-1.2.0.001

m 0010-sm-cp-1.0.3

Note: Do not deploy the HP Codar content pack until after you have deployed the base
content packs. The HP Codar content pack must be deployed separately and after you have
deployed the base content packs.

The deployment may take a few minutes and the dialog will show a progress bar.
When the deployment succeeds, click Close to close the dialog.

Click the Deploy New Contenticon.
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10. Click the Add files for deploymenticon.

11. Navigate to the CSA_HOME\Tools\ComponentTool\contentpacks\ directory, select all the
content packs, and click Open.

12. Click Deploy.
The deployment may take a few minutes and the dialog will show a progress bar.

13. When the deployment succeeds, click Close to close the dialog.

Deploy HP Codar content pack

The HP Codar content pack must be deployed after you have deployed the HP Operations
Orchestration content packs.

Download the HP Codar HP Cloud Content Capsule using the HP Cloud Content Capsule Installer.
You can access the HP Cloud Content Capsule Installer from the CSA_
HOME\tools\CSLContentInstaller directory afterinstalling HP Codar. For details about the HP
Cloud Content Capsule Installer, see the HP Cloud Service Automation Content Pack User Guide.

Set up system accounts for the HP Codar content pack

Set up system accounts for the HP Codar content pack:
1. Loginto HP Operations Orchestration Central.
2. Click the Content Management button.
3. Select Configuration Items > System Accounts.
4. Click the Add icon.

5. Enter the following information if it is not already configured:

Field Recommended value
System Account Name CODAR_REST_CREDENTIALS
User Name ooInboundUser

Password cloud

Note: The User Name configured forthe CODAR_REST _CREDENTIALS System Account
setting must match the Override Value(HP Operations Orchestration version 10.21)
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configured for the CODAR_0O0_USER system property setting.

6. Click Save.

Set up system properties for the HP Codar content pack

Set up the following system properties for the HP Codar content pack:
1. Loginto HP Operations Orchestration Central.
2. Click the Content Management button.
3. Select Configuration Items > System Properties.
4. Click the Add icon.

5. Enter the following information if it is not already configured:

Field Recommended Value

Name CODAR_REST_URI

Override Value https://<codar_hostname>:8444/csa/api
6. Click Save.

Configure HP Single Sign-On

For instructions, see "Configure HP Single Sign-On between HP Codar and HP Operations
Orchestration" on page 60.

Configure external HP Operations Orchestration

Complete the following tasks to configure HP Operations Orchestration to integrate with HP Codar:
« "Add JRE to system path" on the next page
« "Install HP Codar content packs" on page 55
« "Configure internal users" on page 55

« "Deploy content packs required by HP Codar" on page 56
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« "Set up system accounts for HP Codar content pack" on page 58
« "Set up system properties for HP Codar content pack" on page 59

« "Configure HP Single Sign-On" on page 59

Note: In the following instructions, CSA_HOME is the directory in which HP Codar is installed and
ICONCLUDE_HOME is where you installed HP Operations Orchestration.

Be sure all the latest patches for HP Operations Orchestration have been installed. See the HP
Codar System and Software Support Matrix for more information.

Add JRE to system path

The HP Codar flows that are imported require that a JRE be included in the system path on the system
running HP Codar.

On Windows:

1. Open the Environment Variables dialog:

a. Right-click Computer and select Properties.
b. Select Advanced System Settings.
c. Click Environment Variables.

2. Select the Path system variable.

3. Click Edit.

4. Atthe end of the value for Variable value, add a semicolon (;) and the following path:
If HP Operations Orchestration and HP Codar are installed on the same system:
ICONCLUDE_HOME\java\bin
or
If HP Operations Orchestration and HP Codar are installed on different systems:
CSA_JRE_HOME\bin

5. Click OK and close all windows.

On Linux:

Open a shell and enter the following command:
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If HP Operations Orchestration and HP Codar are installed on the same system:

export PATH=$PATH:$ICONCLUDE_HOME/java/bin

or

If HP Operations Orchestration and HP Codar are installed on different systems:

export PATH=$PATH:CSA JRE_HOME/bin
Note: By setting the system path, all applications (that require a JRE) use the JRE that is installed
with HP Operations Orchestration or HP Codar (depending on the path you configured and if it is
the only path or the first path set to a JRE in the system path). If you need to run another JRE with

an application, you must type in the relative path to that JRE in order to run it (for example, when
you configure SSL).

Install HP Codar content packs

Install the HP Codar content packs by running the HP Cloud Content Capsule Installer. Download the
HP Codar HP Cloud Content Capsule using the HP Cloud Content Capsule Installer. You can access
the HP Cloud Content Capsule Installer from the CSA_HOME\tools\CSLContentInstaller directory
after installing HP Codar. For details about running the HP Cloud Content Capsule Installer, see the
HP Cloud Service Automation Content Pack User Guide.

Configure internal users

Internal users can be used to configure HP Operations Orchestration for HP Codar.
1. Loginto HP Operations Orchestration Central.
2. Click the System Configuration button.
3. Select Security > Internal Users.
4. Click the Add (+)icon.

5. Enter the following information:

Field Recommended value

User Name codaroouser

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN
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The codaroouser user is used to import the HP Operations Orchestration flows. When importing
flows, this user is configured in the HP Operations Orchestration input file used by the process
definition tool.

6. Click Save.
7. Enable authentication by selecting the Enable Authentication check box.
8. Select OK in the confirmation dialog.

9. Enter the following information:

Field Recommended value

User Name admin

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN
10. Click Save.

11. Enable authentication by selecting Enable Authentication.
12. Click OK in the confirmation dialog.

13. Log out of HP Operations Orchestration Central and log back in as the codaroouser.

Deploy content packs required by HP Codar

Download the HP Codar HP Cloud Content Capsule using the HP Cloud Content Capsule Installer.
You can access the HP Cloud Content Capsule Installer from the CSA_
HOME\tools\CSLContentInstaller directory after installing HP Codar. For details about the HP
Cloud Content Capsule Installer, see the HP Cloud Service Automation Content Pack User Guide.

The HP Codar content pack must be deployed after the base HP Operations Orchestration content
packs have been deployed.

Verify the deployed content packs

To verify that all content packs were successfully deployed during installation, complete the following
steps:

1. Log in to HP Operations Orchestration Central.

2. Click the Content Management button.

3. Click the Content Packs tab.
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4. Look for the names and versions of content packs in the list. If a content pack is missing, follow the
instructions below to manually deploy it.

The content packs that should have been automatically deployed are:
« CSA-HPOO

. CODAR

o EXISTING-INFRASTRUCTURE-WINDOWS
« CSA-VMWARE

« CSA-SITESCOPE

« CSA-SA

o CSA-HP-HELION-PUBLIC-CLOUD

« CSA Chef Provisioner

« CSA-AMAZON

« SM

« SA

« Virtualization

« HP Solutions

e Cloud

« Base

o EXISTING-INFRASTRUCTURE

o« CSA-Docker

Deploy the HP Operations Orchestration and component tool content packs

If one or more of the base HP Operations Orchestration or HP Codar component tool content packs are
not deployed, you must deploy them manually.

To manually deploy the HP Operations Orchestration or HP Codar component tool content packs,
complete the following steps:

1. Log into the existing HP Operations Orchestration Central.
2. Click the Content Management button.

3. Click the Content Packs tab.
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4. Inthe Deploy New Content dialog, click the Add files for deploymenticon.
5. Click the Deploy New Contenticon.
6. Click the Add files for deploymenticon.

7. Navigate to the CSA_HOME\oo\OOContentPack\ directory. Select, open, and deploy the following
HP Codar content packs in the order shown below:

m 0010-base-cp-1.4.4

m 0010-cloud-cp-1.4.0

m 0010-hp-solutions-cp-1.4.0

m 0010-virtualization-cp-1.4.0

m 0010-sa-cp-1.2.0.001

m 0010-sm-cp-1.0.3

The deployment may take a few minutes and the dialog will show a progress bar.
8. Click the Deploy New Contenticon.
9. Click the Add files for deploymenticon.

10. Navigate to the CSA_HOME\Tools\ComponentTool\contentpacks\ directory, select all the
content packs, and click Open.

11. Click Deploy.
The deployment may take a few minutes and the dialog will show a progress bar.

12. When the deployment succeeds, click Close to close the dialog.

Set up system accounts for HP Codar content pack

Set up system accounts for the HP Codar content pack:
1. Loginto HP Operations Orchestration Central.
2. Click the Content Management button.
3. Select Configuration Items > System Accounts.

4. Click the Add icon.
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5. Enter the following information if it is not already configured:

Field Recommended value
System Account Name CSA_REST_CREDENTIALS
User Name oolnboundUser
Password cloud

Note: The User Name configured for the CSA_REST_CREDENTIALS System Account setting
must match the Override Value(HP Operations Orchestration version 10.21) configured for
the CODAR_OO_USER System Property setting.

6. Click Save.

Set up system properties for HP Codar content pack

Set up the following system properties for the HP Codar content pack:
1. Loginto HP Operations Orchestration Central.
2. Click the Content Management button.
3. Select Configuration Items > System Properties.
4. Click the Add icon.

5. Enter the following information if it is not already configured:

Field Recommended Value

Name CSA_REST_URI

Override Value https://<codar_hostname>:8444/csa/api
6. Click Save.

Configure HP Single Sign-On

For instructions, see "Configure HP Single Sign-On between HP Codar and HP Operations
Orchestration" on the next page.
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Configure HP Single Sign-On between HP Codar and
HP Operations Orchestration

If HP Single Sign-On was enabled during installation of HP Codar, HP Single Sign-On can be
configured between HP Codar and HP Operations Orchestration. Configuring HP Single Sign-On
allows you to launch HP Operations Orchestration from the HP Codar Console without having to log in
to HP Operations Orchestration.

HP Codar provides an out-of-the-box user (admin) and password (cloud) and, earlier in this guide, you
configured an internal user for HP Operations Orchestration with the same user name and password.
When HP Single Sign-On is configured between HP Codar and HP Operations Orchestration, this user
can be used for single sign-on. That is, if you are logged in to HP Codar as the admin user, you can
launch HP Operations Orchestration from the HP Codar Console and not have to log in to HP
Operations Orchestration.

You can also configure LDAP users for single sign-on. In order to enable single sign-on for LDAP users,
you must either configure HP Codar and the embedded HP Operations Orchestration to use the same
LDAP source or, if HP Codar and the embedded HP Operations Orchestration use different LDAP
sources, configure the same users in both sources. In either case, the HP Codar user must be
assigned to the Codar Administrator or Service Operations Manager role and the embedded HP
Operations Orchestration user must be assigned any role that allows flows to be viewed.

Note: To use HP Single Sign-On between HP Codar and HP Operations Orchestration, the
systems on which HP Codar and HP Operations Orchestration are installed must be in the same
domain.

Enable HP Single Sign-On

To configure and enable HP Single Sign-On on HP Operations Orchestration, complete the following
steps:

1. Log in to HP Operations Orchestration Central.
2. Click the System Configuration button.

3. Select Security > SSO.

4. Select the Enable checkbox.

5. Enter the InitString. The initString setting for HP Codar and HP Operations Orchestration must be
configured to the same value. In HP Codar, initString is configured in the crypto element in the CSA_
HOME\jboss-as\standalone\deployments\csa.war\WEBINF\hpssoConfiguration.xml file. The
initString value represents a secret key and should be treated as such in your environment (this string is
used to encrypt and decrypt the LWSSO_COOKIE_KEY cookie that is used to authenticate the user for
single sign-on).
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6. Enter the Domain. This is the domain name of the network of the servers on which HP Codar and
HP Operations Orchestration are installed.

7. Click Save.

Configure LDAP Users for Single Sign-On

In order to enable single sign-on for LDAP users, you must either configure HP Codar and HP
Operations Orchestration to use the same LDAP source or, if HP Codar and HP Operations
Orchestration use different LDAP sources, configure the same users in both sources. In either case,
the HP Codar user must be assigned to the Codar Administrator or Service Operations Manager role
and the HP Operations Orchestration user must be assigned any role that allows flows to be viewed.

To configure LDAP for HP Operations Orchestration, complete the following steps:
1. Loginto HP Operations Orchestration Central.
2. Click the System Configuration button.
3. Select Security > LDAP.
4. Enterthe information to configure LDAP.

5. Click Save.
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You have completed the initial installation and configuration of HP Codar and can begin familiarizing
yourself with the capabilities of HP Codar.

Launch the HP Codar Console (type the following URL in a supported Web browser: https://<codar_
hostname>:8444/csa)and log in using the out-of-the-box user (admin) and password (cloud).

See the following sections for post-installation options:
« "Install VMware vCenter" below
« "Install HP SiteScope" on page 64
« "Install HP Server Automation" on page 66
« "Configure resource providers" on page 74
o "Apply HP Codar licenses" on page 75
« "Jenkins" on page 76

« "Import and configure sample designs" on page 82

Install VMware vCenter

Install vCenter according to the manufacturer's recommendations. For example, follow the VMware
best practices for managing individual ESX servers from a vCenter instance. You can find the VMware
documentation at http://www.vmware.com/support/pubs/.

You must have a vCenter instance that can support the flows that actuate vSphere VMs. See HP
Codar System and Software Support Matrix for version requirements.

Both the HP Codar Console Help, which is available in a printable PDF format, and the HP Codar
System and Software Support Matrix are available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. You must sign in or register for an HP Passport.
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Configure VMware vCenter

Configure VMware vCenter by installing prepared templates. In the vSphere environment, a template is
a master copy of a virtual machine that can be used to create many clones. A clone is a copy of a
virtual machine.

You can learn more about creating templates and working with clones in vSphere by referring to
VMware's vSphere Virtual Machine Administration Guide for vCenter Server (EN-000312-02), available
in the VMware documentation. You can find the VMware documentation at
http://www.vmware.com/support/pubs/.

Virtual machines created by the HP Codar solution are created based on virtual machine templates. To
allow applications (such as Apache) to be deployed to the image, you must create a template that
includes HP Server Automation Agent software. See Prepare a VMware Template to Self-Register with
HP Server Automation for more information.

Toinstall a prepared template, do the following:
1. Locate a prepared template.
2. Copy the template folder to the system containing the vSphere client software.

3. From your vSphere client software menu, select View > Inventory > Datastores to see a list of
available datastores on your vCenter server.

4. Right-click one of the available datastores and select Browse Datastore to see the directory
structure of that datastore.

5. Copy the template folder to the datastore by clicking on the Upload files to this datastore
button.

The following image shows the Datastore Browser window with Upload files to this datastore
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highlighted. It also shows a rhel53x64-clone folder that was uploaded to this datastore:
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Consult the vSphere documentation for additional details. You can find the VMware documentation at
http://www.vmware.com/support/pubs/.

Install HP SiteScope

Install HP SiteScope to the correct version and patch level. See HP Codar System and Software
Support Matrix for version requirements.

Installation notes:

« Do notinstall HP SiteScope on the HP Operations Orchestration server. It must be on its own
server.

« Calculate the resources needed for the HP SiteScope server using the information in the HP
SiteScope documentation. This calculation should include the number of target servers that you
expect Codar to monitor.

« During installation, you can change the port for the HP SiteScope service to avoid potential

conflicts with other web servers that use the default port value of 8080. Select any available port on
the system and keep track of the port number that you select.
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Configure HP SiteScope

The following tasks are required to configure HP SiteScope to integrate successfully with HP Codar:
« "Enable HP Codar to configure HP SiteScope monitors" below
« "Manually import additional HP Codar templates" below
« "Configure HP Codar credential profiles" on the next page

« "Configure HP SiteScope administrator credentials" on the next page

Enable HP Codar to configure HP SiteScope monitors

HP SiteScope is installed with a default of secured API calls required for configuring monitors. HP
Codar does not support secured API calls; therefore, you must change this setting. To re-configure HP
SiteScope so it does not use secure APIs, you must make the following change to the configuration:

1. Stop the HP SiteScope service by typing the following command in a console window:
net stop SiteScope
2. Openthe HP SiteScope <sitescopeInstallDir>\groups\master.config filein atext editor.
3. Changethe accessControlled=true property valueto accessControlled=false.
4. Restart the HP SiteScope service by typing the following command in a console window:

net start SiteScope

Manually import additional HP Codar templates

Two additional HP Codar templates, CSA templates Silver and CSA templates Gold, must be
manually imported. These templates are used by the CSA_BP_VCENTER_COMPUTE_SITESCOPE_MODIFY_
v3.20.00.zip service design.

1. Loginto the HP SiteScope Dashboard.

Note: You must be able to access files in the CSA_ HOME\CSAKit-4.5\Lib\sitescope
directory from the HP SiteScope Dashboard. If necessary, copy this directory to the system
from which you are launching the HP SiteScope Dashboard.

2. Select the Templates context.

3. Inthe template tree, right-click SiteScope and select Import.
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4. Browse to CSA_HOME\CSAKit-4.5\Lib\sitescope (or the directory to which this directory was
copied) and import CSA templates Silver.tmpl.

5. Repeat steps 3 and 4, but import CSA templates Gold.tmpl.

Configure HP Codar credential profiles

Configure the credentials used to log in to every Windows system and every Linux system monitored
by HP SiteScope. The credentials to all Windows systems must be the same. Likewise, the
credentials to all Linux systems must be the same.

1. Loginto the HP SiteScope Dashboard.
2. Select Preferences context > Credential Preferences.

3. Edit the LINUX-CSA-TARGETS credential profile and supply login credentials for your Linux
environment.

4. Editthe WINDOWS-CSA-TARGETS credential profile and supply login credentials for your
Windows environment.

Configure HP SiteScope administrator credentials

Configure the credentials used to log in as the administrator of HP SiteScope. These credentials are
used by HP Codar when configuring HP SiteScope resource providers from the HP Codar Console.

1. Loginto the HP SiteScope Dashboard.
2. Select Preferences context > User Management Preferences.
3. Right-click SiteScope Administrator and select Edit User.

4. If not already specified, enter a login name and password for the HP SiteScope administrator.

Install HP Server Automation

Install HP Server Automation to the correct version and patch level. See HP Codar System and
Software Support Matrix for version requirements.

You can determine your version and patch level by using the HP Server Automation Client and
selecting Help > About.

Installation notes:

HP Codar (1.50) Page 66 of 85



Installation and Configuration Guide

« You can use the DHCP services included with HP Server Automation. For information on
configuring a DHCP server with HP Server Automation, see HP Server Automation
Simple/Advanced Installation Guide.

o The HP Server Automation Client should be installed on the HP Operations Orchestration server.

« The HP Server Automation Client does not register right away after installation. A delay occurs
before you can continue with configuration.

Configure HP Server Automation

The following tasks are required to configure HP Server Automation to allow read and write access to
the required areas:

« "Create HP Codar service account" below
« "Create HP Codar administrators group and assign permissions" on the next page
« "Validate Codar service account" on page 69

« "Validate HP Server Automation client" on page 69

Create HP Codar service account

1. Open the HP Server Automation Web Client in a browser.

2. Loginusing the HP Server Automation Administrator user name and password (created when the
HP Server Automation server was installed).

3. Click Administration > Users & Groups.

4. Click New User in the Users tab toolbar and complete the following fields using the values listed
in the following table:

Field Name Value

Last Name Service Account

First Name CSA

Full Name CSA Service Account
Email Address <your email address>
User Name hpcsa

Password <password>

5. Select Superusers from the Group Membership list to enable this option.
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6. Click Save.

7. Click Log Out.

Create HP Codar administrators group and assign permissions

1. Open the HP Server Automation Web Client in a browser.

2. Login using the HP Server Automation Administrator user name and password.
3. Click Administration > Users & Groups.

4. Select the Groups tab.

5. Click New Group and complete the following fields using the values listed in the following table:

Field Name Value
Group Name hpcsa-admin
Group Description HPCSA Administrators
Not Assigned Read & Write
Opsware Read
6. Click Save.

7. Select hpsca-admin in the list of groups.

8. Select the Users tab and add the admin and hpcsa users to the hpcsa-admin group.

9. Click Save.
10. Select the Facilities tab and select Read & Write to the appropriate facility.

If only one facility exists, select Read & Write for it.

11. Click Save.
12. Select the Features tab and click Select All in the header row to select all features.
13. Click Save.
14. Select the Client Features tab and change all values to Read & Write and Yes where applicable.
15. Click Save.

16. Select the Other tab and select all options except Generate Security Reports.
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17. Click Save.
18. Select the OGFS Permissions tab, click Add Permissions, and enter the following permissions:
s Features: Select Run Command on Server.
m Servers: Click the Customers option and select Not Assigned from the list.
m Login Names: Select Opsware user name, and select Log in as and enter root.
19. Click Grant.
20. Click Add Permissions and enter the following permissions:
= Features: Select Launch Global Shell.
21. Click Grant.

22. Click Log Out.

Validate Codar service account

1. Open the HP Server Automation Web Client in a browser and verify that the login screen appears.
2. Login using the Codar Service Account credentials you created in the previous steps.

3. Verify that the HP Server Automation Web Client home page is displayed. A list of tasks and jobs
is shown.

4. Click the Managed Servers option on the left side of the screen and verify that a list of servers
with their IP addresses and operating system information is displayed.

5. Click Log Out and close the Web browser.

Validate HP Server Automation client

1. Connect to the system where HP Operations Orchestration is installed.
2. Verify that the client is installed.

= |f anicon appears on the desktop labeled HP Server Automation Client or a link appears in the
Start Menu, the client is installed. Continue to step 3.

m |f neither the icon nor the Start Menu link appear, then you need to install the client by
performing the following steps:

i. Openthe HP Server Automation Web Client in a browser and select Download
Opsware Launcher at the login screen.
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ii. Install the client using the default parameters.
You must have a JRE installed in order to use the Opsware Launcher on a Windows system.
3. Launch the client with the following credentials:
m Username: hpcsa
m Password: <hpcsa password>
m Core Server: <SA Server Host Name>
The above login information may vary depending on your installation.

4. Verify that the HP Server Automation application starts and Device Groups appear in the left hand
navigation pane.

5. Click All Managed Servers and verify that a list of servers with their names, IP addresses, and
operating system information is displayed.

6. Exit the client.

Prepare VMware template

The steps below prepare a VMware template to self-register with HP Server Automation.

Virtual machines (VMs) created by the HP Codar solution are created based on virtual machine
templates. The HP Codar flows reference a vSphere template name, and perform a clone operation to
provision new virtual machines. These templates would generally provide an operating system image
only, with no application software installed.

To allow applications (such as Apache) to be deployed to the image, you must install and configure HP
Server Automation and create a template that includes the HP Server Automation Agent software. That
is, in order to manage the virtual server and to install application software, the clones are configured to
self-register upon power-on with an HP Server Automation system. Once registered as a managed
server, software policies are applied to the server in order to install and configure the correct
applications. See the HP Server Automation Policy Setter Guide and the HP Server Automation
Application Deployment User Guide in the HP Server Automation documentation for more information
on managing servers and configuring software policies.

« "Template preparation overview" on the next page

» "Detailed process" on the next page

« "Provision an operating system on a virtual machine" on page 72
» "Sanitize agent configuration on a template machine" on page 72
» "Basic customization" on page 74

« "Install prepared template" on page 74
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Template preparation overview

For cloned virtual machines to register with the HP Server Automation system upon power-on, prepare
a template with an HP Server Automation agent. The following is a general outline of the steps to be
performed:

« First, create a virtual machine with the appropriate operating system image that you would like to
template. Provision the VM with an operating system through any method supported by vSphere:

m  Manually install the operating system on a prepared, configured VM.

= Provision the operating system through a network boot operation from the HP Server Automation
system.

See the appropriate vSphere documentation to create a new virtual machine with an installed
operating system image.

« When preparing a virtual machine as a template to be used to clone many new virtual machines,
leave the configuration as generic as possible. No hostname can be configured, and the network
configuration can be obtained via DHCP.

« Install and test the appropriate VMware Tools on the virtual machine.

« Install the HP Server Automation agent. The agent registers the template with the HP Server
Automation system so that this machine is in a Managed state for the next step.

o An APX utility in the HP Server Automation system library is run to prepare the agent on the virtual
machine to re-install and register with the HP Server Automation system on the next bootup.

« The virtual machine is shut down and converted to a template.

« Delete the virtual machine server record from the HP Server Automation system.

Detailed process

See the vSphere documentation set for detailed information on the creation, configuration, and
operating system installation for a new virtual machine. There are several options to install an operating
system onto a new virtual machine. One of the options available is to use the PXE network boot facility
from the HP Server Automation server, with an operating system installation profile that integrates the
installation of an HP Server Automation agent. A virtual machine which is provisioned using this
method starts the agent upon bootup, and attempts to register it with the HP Server Automation
system.

If you use another method to provision an operating system on the virtual machine, the HP Server
Automation agent can be installed from the HP Server Automation system. See the product
documentation for an expanded discussion of this process. The following instructions describe one
method.
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Provision an operating system on a virtual machine

1.

Boot the virtual machine and make sure that it is connected to the network. Verify that the HP
Server Automation (HP SA) system can be reached.

Discover the virtual machine in the Unmanaged Servers (HP SA 9.x) or SA Agent Installation
(HP SA 10.x) window in HP Server Automation. You can scan an entire subnet or enter the IP
address for the virtual machine and initiate a scan to discover it.

Select the virtual machine, right-click, and then select Manage Server (HP SA 9.x) or Install SA
Agent (HP SA 10.x). A new dialog opens.

Provide the appropriate login credentials, and select the action to verify prerequisites, copy
installer, and install the agent. Set any desired Installer Options at this time, referring to the HP
Server Automation documentation for details.

Click OK.

When the installation process completes successfully, the agent is installed, and the virtual
machine is visible in the All Managed Servers tab. The hostname has not been set, as we plan to
convert this virtual machine to a generic template. So, the default host name is used for the virtual
machine.

From the Server Information Properties tab, select the virtual machine and press Enter.
Select Properties.

Record the Object ID of the virtual machine, which can be found in the Management Information
section of the Properties panel.

Sanitize agent configuration on a template machine

The agent on our virtual machine template must be prepared to install and register a new machine
server with HP Server Automation each time we create a new clone. To prepare the agent we must
sanitize the agent configuration on our template machine by doing the following:

1.

2.

3.

4.

5.

Switch to the Library tab in the HP Server Automation client.

Expand the Extensions folder.

Select Program.

Locate the BRDC HPSA agent sanitizer Automation Platform Extension (APX).
Execute the BRDC HPSA agent sanitizer APX:

a. Right-click the APX and select Run.

b. Select the Options tab in the Run Program Extensions dialog.
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c. Inthe Specify any needed parameters for this program execution field, enter the Object
ID, which you previously obtained for the virtual server template:

ERHI‘I Program Extension

k]

Runtime Options

Ruritime Lser: hpcsa
'ﬂ. Notifications Program Tirmeout : IE_-ﬂ rriruskeds)
[#] 3ob status

Lsage: chone <Source VM SA 1D

Specify any nesded parameters For this program ecesoution

[7340001]
Help & Dutput Options &
Options The sysbem can retain a macimum of the last 10 KB of program output per server
Speify additional program extension (" Discard all program output

' ot {% Retain program outpaot

More help... Zize of the output bo retain (KB) | 10 'I

Back. et Start Job Cancel

d. Click Start Job.

e. Shut down the virtual machine after the job completes successfully and the agent has been
prepared.

Do not reboot this virtual machine again until after it has been converted to a vSphere
template.

f. Using the vSphere client, convert this virtual machine to a template.
g. Thelast stepis to clean up the server records for the virtual machine template from HP Server
Automation. In the All Managed Servers tab:
i. Deactivate the server.

ii. Delete the server.

The template is now ready to use to clone new virtual machines. HP Codar uses a simple
customization template that sets the hostname equal to the VM name. Additional customization is
possible during the clone operation. See "Basic customization™" on the next page.
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When a newly cloned virtual machine powers up, the HP Server Automation Agent installs and then
contacts the HP Server Automation system to self-register. Shortly after power on, you can refresh the
All Managed Servers view in the HP Server Automation client to locate the new virtual machine record.

Basic customization

Perform the following basic customizations:

1. Onthe vCenter environment click View > Management > Customization Specifications
Manager.

2. Click the New icon.
3. Select Windows or Linux for your Target Virtual Machine OS. You can create one of each.

4. If you are creating a Windows target, name it useVmName_Windows. If you are creating a UNIX
target, name it useVmName_Linux.

5. Customize as appropriate, noting two important items:
m  On the screen with the NetBIOS Name you must choose Use the virtual machine name.

m If the virtual machine name exceeds 15 characters, it will be truncated.

Install prepared template

The template must be installed on the system containing the vSphere client software. See Configure
VMware vCenterfor more information.

Consult the vSphere documentation for additional details. You can find the VMware documentation at
http://www.vmware.com/support/pubs/.

Configure resource providers

HP recommends that you follow this procedure to create two resource providers. These resource
providers should be associated with two different data centers which are associated with two different
environments, likely named Development and Testing.

To configure a resource provider,
1. Open HP Codar at https://<ipadress>:<port>/csa

where <jpadress> is the IP address or host name of the HP Codar server, and <port> is the port
number, which is 8444 by default.

2. Login as the administrator. The default user name is admin and the default password is cloud.

3. Click the Providers tile.
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4. Under All Providers on the left, select the provider type that will be used for application
deployment.

5. Click Create and enter details for the resource provider you will use for application deployment.

6. After the provider has been created, select the Properties tab and provide the values for the
properties that are defined for the provider type.

For example, if the provider chosen is the vCenter provider, you might create a property named
DATACENTERNAME with the value DEVELOPMENT.

7. Return to the main Providers screen and choose By Environment in the drop-down field in the
upper right corner of the screen.

8. Click Create your first Resource Environment.
9. Enter details for the resource environment.

The resource environment you enter here should be the same as the Environment you entered in
"Install HP Codar Jenkins plug-in" on page 77.

10. Click Select Resource Providers.

11. Add the provider you created and then click Save.

Apply HP Codar licenses

After installation is complete, apply an HP Codar permanent license. You can then apply an HP Cloud
Service Automation permanent license, if desired. After an HP Cloud Service Automation license is
installed, you can use all of HP Codar and HP Cloud Service Automation features.

The following license types are available:
o HP Codar permanent license only.
o HP Cloud Service Automation permanent license only.

If you install HP Cloud Service Automation, then you must add an HP Cloud Service Automation
license first. If you install HP Codar, then you must install an HP Codar license first. After you apply a
base license, you can add an upgrade license. If you have licenses for both, you can apply an HP
Cloud Service Automation and an HP Codar license.

When upgrading, if an HP Cloud Service Automation license is applied to HP Codar, or the HP Codar
license is applied to HP Cloud Service Automation, the upgraded product is always HP Cloud Service
Automation. For details, see "Appendix A: Cross-product upgrade between HP Codar and HP Cloud
Service Automation" in the HP Codar Upgrade Guide.
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OSlI capacity

The number of operating systems you can use in active applications or subscriptions is known as the
OSI capacity. If you have HP Cloud Service Automation and HP Codar licenses, then the OSI capacity
is the lowest of the two. Here’s an example: You have an HP Cloud Service Automation license with
100 OSI and an HP Codar license with 50 OSI, so your OSI capacity is 50.

Jenkins

Jenkins is optional, but you must install Jenkins and dependencies if you intend to use the sample
design, and it is required for the Sample Continuous Deployment Demo purpose.

You should consult product documentation for installation and usage instructions.

Using Jenkins with HP Codar requires the following dependencies:
« Collabnet Subversion Edge: collab.net/support/documentation
« TortoiseSVN: tortoisesvn.net/support.html
« Jenkins: jenkins-ci.org/

. JDK1.7

« Maven: maven.apache.org/guides/index.html

Install Collabnet Subversion Edge

Download and install a version appropriate to your system from collab.net/downloads/subversion.

Install Tortoise
Download and install the latest version from tortoisesvn.net. Use the default settings.

After installation, you will see new options when you right-click a file or folder in Windows Explorer.

Install Jenkins
Download the Windows installer for Jenkins from jenkins-ci.org.

After installation, you should access the Jenkins server at http://localhost:8080 to validate the
installation.
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Install the JDK

Install the JDK version 1.7x on the Jenkins server.

Install the Maven plug-in

Download and install Maven from maven.apache.org.

Configure Jenkins to use with HP Codar

The following steps are for Jenkins version 1.583.

To configure Jenkins to use with HP Codar, complete the following steps:
1. Make sure the JDK and Maven are installed.

2. Logintothe Jenkins Dashboard in a browserat http://<host>:<port>/, substituting the host
and port information appropriate for your Jenkins environment.

3. Click Manage Jenkins.
4. Click Configure System.
5. Inthe JDK section, click Add JDK.
6. Enterthe name and path for JAVA_HOME.
7. Deselect Install automatically.
8. Inthe Maven section, click Add Maven.
9. Enter the name and path for MAVEN_HOME.
10. Deselect Install automatically.
11. Enter the value for MAVEN_OPTS.

12. Click Save.

Install HP Codar Jenkins plug-in

To install the HP Codar Jenkins plug-in, complete the following steps:
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1. Loginto the Jenkins Dashboard in a browser at http://<host>:<port>/, substituting the host
and port information appropriate for your Jenkins environment.

2. Click Manage Jenkins from the Dashboard

3. Click the Manage plug-ins.

4. Select the Advanced tab.

5. Inthe Upload plug-in section, browse to select the following file:

Hewlett-Packard\Codar\CSAKit-4.5\Content Archives\topology\Jenkins plugin\HP_
Codar.hpi

6. Click Upload.

7. Select the Installed tab and verify that the HP Codar plug-in was installed.

Enable the HP Codar Jenkins plug-in

To enable the HP Codar Jenkins plug-in, complete the following steps:
1. Click Manage Jenkins from the Dashboard.
2. Click Configure System.

3. Scroll down to the HP Codar Plug-in section of the Configure System page and select the
Enable check box.

4. Click Save.

Configure Pet Clinic sample application project

HP Codar includes a Pet Clinic sample application project, which is available on HP Live Network
(HPLN) at https://hpln.hp.com/group/project-codar.

To configure the Pet Clinic sample application project, complete the following steps:
1. Check in the source code for the PetClinic project into the Subversion server.
2. Create a new PetClinic project in the Jenkins server using the Build a maven2/3 project option.

3. Click the PetClinic link on the Jenkins Dashboard, and then click the Configure link on the page
that opens.

4. Configure Subversion for Source Code Management for the PetClinic project by choosing the

Subversion Modules option and adding the Subversion PetClinic source code URL in the
Repository URL field.
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5. After saving, update the Subversion credentials like this:

Source Code Management
i

CvS
C cysg Frojectset
T Mone

& cyubversion

Modules Repository URL |-.ttp:,-',-f~.-m1|:l1.u-u:| arworld. com: 8090/5vn/PetClinic/trunk /PetClinic

Local module directary {uptlunaI]L

Repository depth Iinﬁmtl,n' b I

Ignore extemals '

Check-cut Strategy |U5e- 'swn update' as much as possible

Use "swn update” whanever possible, making the buld Faster, But thiz causes the srbfacts from the praviowes buld to re
Repository browser |{Autn}

6. Configure Jenkins to automatically trigger a build if any code is checked-in by selecting the Poll
SCM check box and adding */5 * * * * as the schedule.

7. Scroll down and click Add post-build action, select Archive the artifacts, and then enter
*/* war, target/classes/*/*.shinthe Files to archive text box.

Configure plug-in for Pet Clinic sample application

To configure the plug-in for the Pet Clinic projects, complete the following steps:

1. Click the PetClinic link on the Jenkins Dashboard, and then click the Configure link on the page
that appears.

2. Click Add post build action and select HP Codar plug-in.

Aggregate downstream test results
Archive the artifacts

Build other projects

Deploy artifacts to Maven repository
HP Codar Plugin

Add post-huild action «

3. Enterthe applicable HP Codar plug-in properties:
m HostName — The host name or IP address of the server on which HP Codar is installed.
= Port— The port number on which the HP Codar application is listening.

= Username — The name of a user that has HP Codar administrative privileges.
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m Password — The password for the HP Codar user.

Caution: Do not use the default HP Codar admin user because this might be a security
issue. After installing HP Codar and configuring LDAP, add a user to the Application
Architect role. Use the credentials for that user here.

m Application Design Location — The relative path and filename from the source repository
URL of the application design JSON file, which contains the application to be deployed by HP
Codar (for example, designs\PetClinicApp.json). See “API calls” in the HP Codar APl and
CLI Reference Guide for information on how to get the JSON file using REST APIs.

m Environment — The environment in HP Codar in which the provider that is to be used for
deployment is contained.

Note: The environment value is mandatory if you want to use HP Codar for continuous
deployment.

m Package properties — Specify the component properties of the design that will be
parameterized within the build. The input to this field should be specified in this format:

componentlid:propertylid:propertylvalue,component2id:property2id:property2val
ue, component3id:property3id:property3value

o Component Id/Name— The ID of the component in the application design. This can be
obtained from the Application design's json file. A PetClinic application component could
be: PetClinic_Application_ VERSION__1_GROUPID__com.hp.csa.typeo0ol

o Property Name — The name of the property within the component. This can be obtained
from the Application design's json file. For example, an artifacturl property within the
PetClinic application could be ; artifacturl_a36.

o Property Value — The value of the property. If it is a Jenkins build output artifact, then the
URL of the artifact will be automatically computed and the value will represent the complete
HTTP URL from which this artifact can be downloaded. For example, the Jenkins build
artifact for PetClinic could be : petclinic.war.

o Forexample: PetClinic_Application_ VERSION_ 1 GROUPID
com.hp.csa.type@ool:artifacturl a36:petclinic.war

» Extended Properties File — Optionally enter the name of the properties file. This properties file
needs to be specified only when the user wants to specify a different Cl process than what is
provided by default. This properties file can specify a different HP Operations Orchestration
flow containing necessary Cl logic. You can specify a different flow ID by creating a property
file with key as the uuid and value as the uuid of HP Operations Orchestration flow. For
example, uuid=asdaasdasdsdasdad99o-f.

You can also specify the required properties to this flow as key value pairs in this property file.
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» Nodeld — Enter the component ID for which you want to extract component properties. These
component ids can be obtained from the Application design JSON file which has been exported.
Multiple components are specified by separating those with commas.

For example, you may want to retrieve an IP address and host name of the VCenter
component, VcenterServerType_ VERSION__04.20.0000__GROUPID
com.hp.csa.type0oo2, to run tests on the provisioned server.

= Httpusername — Enter the user name for accessing artifacts from HTTP location. For
example, the username for the Jenkins Server.

m HttpPassword — Enter the password for accessing artifacts from HTTP location. For example,
the password of the Jenkins Server.

m SSLCertificatePath — Enter the SSL certificate path for HP Codar and pick up the certificate
from the HP Codar setup. The certificate will be in the machine where HP Codar is installed in
the path \Hewlett-Packard\Codar\IA-openjre\lib\security\cacerts.

m CertificatePassword — Enter the SSL certificate keystore password for HP Codar. By default
it is changeit.

Sample Pet Clinic extended properties file

Change the extended properties file to the following

## Properties accessed by the ARA API to invoke 00 flows.

##This properties file contains the oo flow id(uuid) as well as the relevant
parameters to be passed to the oo flow.

##Dynamic properties can be specified by <<property>> prefixing and suffixing
with angular brackets. These properties

## will be substituted with the value passed in JSON input.
csaTruststore=C:/codar/cacerts

#uuid of the oo flow. This flow contains the necessary logic for the Continuous
integration process.

#uuid=377898bc-d92e-4e6a-b542-718539fdcb9a

#Specify the artifacts that are built by Jenkins to manage it within ARA. These
artifacts would be dynamically obtained from Jenkins and deployed via ARA.

##Format 1is
componentlid:propertylid:propertylvalue, componentlid:property2id:property2value,
component2id:property3id:property3value where

##twhere COMPONENT1id - represents the id of the component as displayed in the
design

## propertylid - represents the property of the component which needs to be
dynamically replaced
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#i#tpropertylvalue - will represent the artifacts which need to be deployed.
##Sample

#i#Pet_Clinic_DB_Configuration_87424824 fdfd_485d _b392_7e5b58cadbla_
320fb4ee61694fd9a4ea347537de8fcb_ VERSION__1 GROUPID_com.hp.csa.type.VMWARE_
VCENTER@@O1:artifacturl:petclinic.war

#The server node which needs to be queried for obtaining IP address. This is
relevant for Continuous Delivery where tests can be run against the provisioned
virtual machine via ip address.

#serverNodeId=VcenterServerType VERSION__04.10.00000002

#componentid:propertyname: jenkinsout, componentid:propertyname: jenkinsout

Create custom design

You can configure continuous deployment for custom applications by creating custom HP Operations
Orchestration flows.

If a custom application in an enterprise needs continuous deployment users can create deployment
scripts using Chef or HP Operations Orchestration. Those flows can be embraced (imported) as
components in HP Codar and used in the creation of an application design, which can then be exported
from HP Codar in JSON format and checked into the source repository. Jenkins can be configured for a
continuous build. When an application developer checks in the code, a Jenkins build is triggered and
the application is deployed using an application model on a specific environment.

Import and configure sample designs

Sample application designs are installed with HP Codar Console.

These designs are imported to the HP Codar Console when the HP Cloud Content Capsule is
downloaded using the HP Cloud Content Capsule Installer. You can access the HP Cloud Content
Capsule Installer from the CSA_HOME \tools\CSLContentInstaller directory. For details about the HP
Cloud Content Capsule Installer, see the HP Cloud Service Automation Content Pack User Guide.

Import sample designs

Complete the following steps to import any other sample designs manually:
1. Click the Designs tile in the HP Codar Console to go to the main Topology Designs screen.

2. Click Import.

HP Codar (1.50) Page 82 of 85



Installation and Configuration Guide

3. Select a sample application zip file and click Import.
4. Repeat these steps to import the other sample design zip files.

The topology designs for these applications should now be listed under All Designs in the main
Topology Designs screen.

Configure sample designs

Imported sample HP Codar Console designs can be configured using the instructions provided in the
HP Cloud Service Automation Content Pack User Guide.

The sample designs can be validated by deploying the designs using the Test run functionality.
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Installation and Configuration Guide (Codar 1.50)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to clouddocs@hp.com.

We appreciate your feedback!
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